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Introduction



Welcome!
Welcome to Cubase Studio 5.5! This free update to Cu-
base Studio 5 is packed with new features and improve-
ments across several application areas. Most of these are 
direct results of the Nuendo 5 development that we do not 
want to withhold from Cubase Studio 5 – the introduction 
of a completely redesigned MediaBay or the new Video 
Engine with OpenGL support to name a few. This docu-
ment lists and describes features that have been added or 
changed since the release of Cubase Studio 5.0. Some 
chapters known from the previous documentation have 
been completely rewritten and are therefore included in 
their entirety, e.g. for the Sample Editor, where many de-
tail changes can be found. Please take some time to read 
through this documentation for the full scope of all these 
improvements. It will help you getting the most out of Cu-
base Studio 5.5.

This version is compatible with Apple Mac OS X Snow 
Leopard (10.6) and Microsoft Windows 7.

About the program versions
The documentation covers two different operating sys-
tems or “platforms”; Windows and Mac OS X. 

Some features and settings are specific to one of the plat-
forms. This is clearly stated in the applicable cases. In 
other words:

If nothing else is said, all descriptions and procedures 
in the documentation are valid for both Windows and Mac 
OS X.

About the screenshots
Most of the screenshots in this document are taken from 
Cubase. Therefore some of them show features that are 
not available in Cubase Studio.

Key command conventions
Many of the default key commands in Cubase Studio use 
modifier keys, some of which are different depending on 
the operating system. For example, the default key com-
mand for Undo is [Ctrl]-[Z] under Windows and [Com-
mand]-[Z] under Mac OS X.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] 
under Windows or [Command] under Mac OS X, then 
press [Z]”. 

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Win-
dows or [Option] under Mac OS X, then press [X]”.

Please note that this manual might refer to right-click-
ing, e.g. to open context menus. If you are using a Mac 
with a single-button mouse, hold down [Ctrl] and click.
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Working with the new features



The Project Assistant dialog
The Project Assistant dialog is opened by selecting the 
“New Project…” command on the File menu. In this dialog 
you can access recently opened projects and create new 
projects, which can either be empty or based on a template.

The Project Assistant dialog will also open in the following 
cases:

• If you launch Cubase Studio with the option “Show 
Project Assistant” selected on the “On Startup” pop-up 
menu in the Preferences (General page).

• If you hold down [Ctrl]/[Command] while launching Cu-
base Studio.

Opening recent projects
The Recent category in the category bar of the Project As-
sistant dialog contains a list of recently opened projects. 
When you select an item in this category, the Create but-
ton changes to “Open”, allowing you to open the corre-
sponding project. This list is similar to the list in the 
Recent Projects submenu on the File menu.

Choosing a template
In the category bar of the Project Assistant dialog, the 
available factory templates are sorted into the predefined 
categories Recording, Production, Scoring, and Master-
ing. Furthermore, there is a More category which contains 
the default project template and all templates that are not 
assigned to any of the other categories.

When you click on one of the category items, the list be-
low the category bar shows the available factory tem-
plates for this category that were installed with Cubase 
Studio. Any new templates that you create are added at 
the top of the corresponding list for convenient access.

• To create an empty project that is not based on a tem-
plate, select the “Empty” entry in the More category and 
click the Create button.
An empty project is also created if no template is selected in the cur-
rently shown category.

• You can rename or delete a template by right-clicking it 
in the list and selecting the corresponding option on the 
context menu.

Choosing a project location
The options in the lower part of the dialog allow you to 
specify where the project is stored. 

• Select “Use default location” to create the project in the 
default project location (as shown in the path field), and 
click Create. 
In the “Project folder” field you can specify a name for the project folder. 
If you do not specify a project folder here, the project will reside in a 
folder named “Untitled”.

To change the default project location, simply click in 
the path field. A file dialog opens, allowing you to specify a 
new default location.

• Select “Prompt for project location” and click Continue 
to create the project in a different location.
In the dialog that appears, specify a location and a project folder.

Open Other
The “Open Other” button allows you to open any project 
file on your system. This is identical to using the Open 
command from the File menu.

Category 
bar

Template 
list

Location 
options

Open Other button
8
Working with the new features



Saving templates
The “Save as Template” dialog now has an Attribute In-
spector section, where you can assign the template to one 
of the template categories shown in the Project Assistant 
dialog and/or enter a description for the template. This de-
scription will also be visible in the Project Assistant dialog.

• Simply select a category value from the Template Cate-
gory pop-up menu and/or enter a description in the Con-
tent Summary field.

If you do not choose a Template Category attribute, 
the new template will be shown in the More category in 
the Project Assistant dialog.

The Jog/Scrub wheel
The Jog/Scrub wheel is now available in Cubase Studio.

The Shuttle Speed control

The shuttle speed control (the outer wheel on the Trans-
port panel) allows you to play the project at any playback 
speed, forwards or backwards. This provides a quick way 
to locate or “cue” to any position in the project.

• Turn the shuttle speed wheel to the right to start play-
back.
The further to the right you move the wheel, the faster the playback 
speed. 

• If you turn the wheel to the left instead, the project will 
play backwards.
Similarly, the playback speed depends on how far to the left you turn the 
wheel.

Project scrubbing – the Jog Wheel

The middle wheel on the Transport panel serves as a jog 
wheel. By clicking and dragging it to the right or left you 
will move the playback position manually forwards or 
backwards – much like scrubbing on a tape deck. This 
helps you pinpoint exact locations in the project. In the 
Transport category of the Key Commands dialog you can 
also set up key commands for the commands Jog Left/
Right. For more information about the Key Commands di-
alog, please refer to the Key Commands chapter of the 
Operation Manual.

• Note that the jog wheel is an “endless rotary encoder” – 
you can turn it as many times as needed to move to the 
desired location.
The faster you turn the wheel, the faster the playback speed.

• If you click the jog wheel during playback, playback will 
automatically stop.

The nudge position buttons
The + and – buttons in the middle of the Shuttle/Jog sec-
tion allow you to nudge the project cursor position one 
frame at a time to the right or left.

General editing improvements

New event selection option
There is a new option on the Select submenu of the Edit 
menu called “Events under Cursor”. It automatically se-
lects all events on the selected tracks that are “touched” 
by the project cursor.

Zooming with the mouse wheel
You can now press [Ctrl]/[Command] and turn the mouse 
wheel to zoom in on or out of the current mouse pointer 
position.
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User interface improvements

Consolidated toolbars
The toolbars in the Project window, the Sample Editor, 
and the MIDI editors have been slightly redesigned and 
now present a consolidated look and feel. Some items 
were regrouped to move elements belonging together 
closer to each other.

The Set up Window Layout button

The toolbars now feature a “Set up Window Layout” but-
ton that allows you to show or hide various window ele-
ments, such as the info line. There are no longer individual 
buttons to show or hide these elements.

When you click the “Set up Window Layout” button, a 
transparent pane appears, covering the window. In the 
center of it is a gray area containing checkboxes for the 
different elements. In this pane, activate or deactivate the 
elements that you want to see or hide (respectively).

In the Key Editor and Drum Editor, this button is 
named “Show Info Line”. Use it to directly hide or show 
the info line.

The Select Color pop-up menu

The Color Selector and the small color strip below the 
Color tool have been merged into a single pop-up menu.

New look for Add Track dialogs
The Add Track dialog has a new design that fits in with the 
new look and feel of the MediaBay. It is described in detail 
in the section “Working with MediaBay-related windows” 
on page 31). 

Redesign of the info line
The appearance of the info line in the Project window and 
all editors was enhanced to improve readability. It shows 
the same information as before.

Redesign of the Edit History dialog
The Edit History dialog has a new look and feel. It works 
as before with the only difference that it is now set to stay 
“always on top”.

Enhanced editing in the VST 
Connections window 
On the different tabs of the VST Connections window, the 
corresponding busses are shown in a table containing a 
tree view with expandable entries. When you have set up 
all the required busses for a project it might be necessary 
to edit the names and/or change port assignments. Cu-
base Studio provides a number of new features to make 
such tasks easier.

Determining how many busses a device port is 
connected to
To give you an idea how many busses a given port is al-
ready connected to, the busses are shown in square 
brackets on the Device Port pop-up menu, to the right of 
the port name.

Up to three bus assignments can be displayed in this way. 
If more connections have been made, this is indicated by a 
number at the far right.

Therefore if you see the following:

Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)...

this means that the Adat 1 port is already assigned to 
three stereo busses plus two additional busses.
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Identifying exclusive port assignments

In some cases (i.e. for certain channel types) the port as-
signment is exclusive. Once a port has been assigned to 
such a bus or channel, it should not be assigned to an-
other bus since the assignment to the first bus is broken in 
that case.

To help you identify such exclusive port assignments and 
avoid accidental reassignment, the corresponding ports 
are marked in red on the Device Port pop-up menu.

Selecting/Deselecting multiple entries

• Using the key commands [Ctrl]/[Command]-[A] (Select 
All) and [Shift]-[Ctrl]/[Command]-[A] (Select None) you 
can select or deselect all entries in the Bus Name column.
Note that for this to work the table on the current tab needs to have the 
focus. This can be achieved by clicking anywhere on the background of 
the table.

• By holding [Shift] when selecting entries in the Bus Name 
column, you can select multiple entries at the same time.
This is useful for automatic renaming or changing the port assignments 
globally, see below.

If you select a subentry (e.g. a speaker channel in a 
bus) the parent entry is automatically selected as well.

Selecting entries by typing the name

In the Bus Name list you can jump to an entry by typing the 
first letter of the bus name on the keyboard.

Navigating the Bus Name list using the [Tab] key

By pressing the [Tab] key you can jump to the next entry in 
the Bus Name list, allowing you to rename your busses 
quickly. Similarly, by pressing [Shift]-[Tab] you can return 
to the previous list entry.

Automatically renaming selected busses

You can rename all the selected busses at once using in-
crementing numbers or letters from the alphabet.

• To use incrementing numbers, select the busses that 
you want to rename and enter a new name for one of the 
busses, followed by a number.
For example, if you have eight inputs that you want to be named “In 1, 
In 2, …, In 8”, you select all the busses and enter the name “In 1” for the 
first bus. All other busses are renamed automatically.

• To use letters from the alphabet, proceed as with num-
bers, but enter a capital letter instead of a number.
For example, if you have three FX channels that you want to be named 
“FX A, FX B, and FX C”, you select all the channels and enter the name 
“FX A” for the first. All other channels are renamed automatically. The last 
letter to be used is Z. If you have more selected entries than there are let-
ters available, the remaining entries will be skipped.

You do not have to begin renaming with the topmost 
selected entry. The renaming will start from the bus where 
you edit the name, will go down the list to the bottom and 
then continue from the top until all selected busses have 
been renamed.

Changing the port assignment for multiple busses

To change the port assignment (or the output routing in 
case of groups/FX channels) for multiple entries in the 
Bus Name column at the same time, you need to select 
the corresponding busses first.

• To assign different ports to the selected busses, press 
[Shift], open the Device Port pop-up menu for the first se-
lected entry (i.e. the topmost bus) and select a device port.
All subsequent busses are automatically connected to the next available 
port.

• To assign the same port to all selected busses, press 
[Shift]-[Alt]/[Option], open the Device Port pop-up menu 
for the first selected entry (i.e. the topmost bus) and select 
a device port.

Using this procedure, you can also set all selected 
busses or channels to Not Connected.

! This will only work if the table has the focus. To do 
this, simply select any list entry.

! When using letters instead of numbers, it is impor-
tant to note that these must be preceded by a space. 
If you leave out the space before the letter or if you 
do enter neither a letter nor a number, only the first 
selected entry is renamed.
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New and improved automation 
features

The automation panel was slightly redesigned and ex-
panded so that you will now find a few familiar functions in 
a different place (e.g. the Global Automation Mode pop-
up menu, the Trim button and the Functions pop-up 
menu). The “Return Time”, and “Reduction Level” settings 
can now be found in the Automation Preferences, opened 
by clicking the corresponding button in the lower left cor-
ner of the panel. Here you will also find the “Show Data on 
Tracks” and “Continue Writing” (previously “Allow Con-
tinue Writing after Transport Jump”) options, previously 
found on the Options pop-up menu.

Trim improvements
When enabling Trim on the Automation panel, a trim curve 
is now positioned in the exact middle position of your au-
tomation track. You can use the trim curve to modify the 
original automation curve. Just drag the trim curve up or 
down and add automation events to it. These increase or 
decrease the values of the original automation curve, but 
allow you to preserve the original data.

You can now freeze your trim curve automatically or manu-
ally and render all trim data into a single automation curve.

To freeze your trim curve automatically, open the Freeze 
Trim pop-up menu in the Automation Preferences, and se-
lect one of the following options: Use “On Pass End” to 
perform a freeze whenever a write operation is finished, or 
“On Leaving Trim Mode” to freeze the trim data when Trim 
mode is switched off.

To freeze your trim curve manually, select the Manually op-
tion on the Freeze Trim pop-up menu in the Automation 
Preferences. You have the following possibilities to freeze 
your trim data manually:

• On the automation track, click on the parameter name 
and select the “Freeze Trim” option from the pop-up menu 
to freeze a specific parameter of one track.

• Open the Functions pop-up menu on the Automation 
panel and select “Freeze All Trim Automation in Project” to 
freeze all tracks in the project.

• Open the Functions pop-up menu on the Automation 
panel and select “Freeze Trim Automation of Selected 
Tracks” to freeze all selected tracks.
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The Fill options
The automation panel now features an additional Fill sec-
tion.

The Fill options define what happens in a specific section 
of your project when you punch out of a running automa-
tion pass.

The Fill options write one particular value across a defined 
section of your automation track – any previously created 
data within this section is overwritten.

The following Fill options are available:

To Punch

Let’s say you are rolling, in realtime, over a scene cut and 
volume must be softer in the next scene – you do not yet 
know how much softer, but the change in volume from the 
first to the second scene must be abrupt.

1. Select “Touch” as automation mode and click the “To 
Punch” button once to activate it as Fill option.
The “To Punch” button is highlighted. 

2. Start rolling somewhere during the first scene and 
touch the fader at the moment of scene change.
The automation pass is punched in.

3. Move the fader until you have found the volume setting 
you need in the second scene and release the fader to 
punch out.
The volume curve is set from the point of punch out back to where you 
punched in. The values written while moving the fader to find the right 
value are deleted, and the volume jumps at exactly the right moment from 
the value set in the first scene to the value found for the second scene.

To Start

“To Start” is similar to the “To Punch” option, but with the 
following difference: When “To Start” is selected, punch-
ing out of automation will fill the automation track from 
where you punched out to the start of the project.

To End

Imagine you are automating volume for the background 
tracks of a two-minute scene. Rather than holding the 
fader for two minutes, you can proceed as follows: 

1. Select “Touch” as automation mode and click the “To 
End” button once to activate it as Fill option.
The “To End” button is highlighted. 

2. Start rolling and touch the parameter control to punch 
in the automation pass.

3. Move the fader until you have found the setting you 
want and release the fader.
This will punch out the writing of automation data. As you let go of the 
fader, the automation curve will take the found value setting, from where 
you punched out to the end of the project.

Loop

To use the Loop option, you must first set up a loop range 
with the left and right locators. When you then select 
Loop, punching out will set the found value within the 
range defined by the left and right locator.
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Fill combinations

You can also combine the various Fill options. 

• Combining “To Punch” and “To End” will fill the automa-
tion track from the punch in position to the end of the 
project.

• Combining “To Start” and “To End” will fill the automa-
tion track from the beginning to the end of the project.

One shot vs. continuous fill

The Fill options can be used in two different ways:

• When you click one of the Fill buttons, it is highlighted, 
and will be enabled during the next automation pass.
Afterwards, the option is disabled again.

• If you click a Fill button a second time, a lock symbol is 
displayed on the highlighted button, indicating that you 
are permanently in “Fill to X” mode and that the operation 
can be repeated as many times as you wish.
Clicking the button a third time disables the corresponding Fill option.

Drawing curves with Fill enabled

You can use the Fill options on the Automation panel in 
combination with the Pencil tool. This provides you with an 
extremely powerful method for writing automation data 
manually:

1. Open an automation track and select the Pencil tool.

2. On the Automation panel in the Fill column select “To 
End”.

3. Click and draw to create an automation curve.

4. Release the mouse button.
At the moment of release, a final automation event is created. The automa-
tion curve is written from this last event through to the end of the project.

This procedure can be used with all the Fill options. 

Project Synchronization Setup 
dialog improvements
The Project Synchronization Setup dialog has been opti-
mized to make the relationships between the different ele-
ments involved in synchronization more evident. The 
arrows now clearly indicate the sources and destinations 
in the information/signal flow. Furthermore, some of the 
descriptions have been renamed to make them more con-
sistent and easier to understand.

Export Audio Mixdown 
improvements

New naming options
The Export Audio Mixdown dialog now has an additional 
button in the File Location section. Clicking the “Naming 
Scheme…” button opens a separate pop-up window.
14
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Here you can choose a number of elements that will be 
combined to form the file name. Depending on the settings 
in the Channel Selection section, the following elements 
are available: Name, Mixer Index, Channel Type, Channel 
Name, and Project Name.

The elements are defined as follows:

By combining the available naming elements, you can 
make sure that all the files of a batch are exported with 
unique names. If you have set up a naming scheme that 
would result in identical file names, a warning message 
appears when you click the Export button.

• To add an element, press the “+” button on the far right, 
and to remove an element from the naming scheme, click 
the corresponding “-” button.
You can also remove an element by dragging it out of the Elements sec-
tion.

• To rearrange the sequence, simply click on an element 
and drag it to a different position.

• To choose a different element for a certain position, 
click on the element name and select a new entry from the 
pop-up menu.
Each element can only be used once in a naming scheme. The pop-up 
menu therefore shows only those elements that are still available. 

Below the Elements section you will find some additional 
options:

To close the Naming Scheme pop-up window, simply 
click anywhere outside the pop-up window. The gener-
ated name will now also be shown to the right of the 
“Naming Scheme…” button.

New L/R channels option
The “L/R Channels” option in the Audio Engine Output 
section allows you to export only the left and right sub-
channels of a multi-channel bus into a stereo file.

The Update Display option was moved to the bottom 
of the dialog.

New Import into Project option
The Import into Project section contains several options 
for importing the resulting mixdown files back into the ex-
isting or into a new project. If you activate the Pool check-
box, the resulting audio file will automatically be imported 
back into the Pool as a clip.

Now, there is also a “Pool Folder” text field, where you can 
specify in which Pool folder the clip will reside.

Gain inverse for channel EQ
Each EQ module (in the VST Channel Settings window or 
the Inspector) now features a button to invert the corre-
sponding EQ band (i.e. reflect the curve along the x axis). 
This button is located to the right of the EQ module’s On/
Off button. The button is hidden when the EQ module is 
deactivated.

This is very useful if you want to filter out unwanted noise. 
While looking for the frequency to omit, it sometimes 
helps to boost it in the first place (set the filter to positive 
gain). After you have found the frequency, you can use the 
Inverse button to cancel it out.

Element Description

Name The name that you entered in the Name field (in the File 
Location section).

Mixer Index The number of the Mixer channel.

Channel Type The type of audio-related channel that is being exported.

Channel Name The name of the exported channel.

Project Name The name of the Cubase Studio project.

Option Description

Separator Allows you to enter any character sequence to be used 
as a separator between the naming elements (e.g. a hy-
phen enclosed in spaces).

Leading Zeros This controls how many leading zeros the Counter and 
Mixer Index components will have. For example, if you set 
this to “2”, the numbers from 1 to 10 will be written as 
001 to 010.

Counter Start 
Value

Here you can enter a number that is used as the first 
Counter value.
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Redesign of the Marker window
While the display of the markers on the Marker track has 
been refreshed for enhanced clarity, the Marker window 
has been completely redesigned:

In the Marker window you can view and edit markers. The 
markers on the marker track are displayed in the marker 
list in the order in which they occur in the project. 

To open the Marker window, you have the following possi-
bilities:

• Open the Project menu and select “Markers”.
• Click the Show button in the marker section on the Transport 

panel.
• Use the corresponding key command (by default [Ctrl]/[Com-

mand]-[M]).

The Type pop-up menu
• By selecting an entry from the Type pop-up menu, you 
select which markers (position markers, cycle markers, or 
all) are shown in the marker list.

Adding, moving, and removing markers 
• To select a marker, click on it in the Marker window. 

• To edit a selected marker, click on it. 
Select multiple markers by [Shift]-clicking or [Ctrl]/[Command]-clicking 
them.

• To add a position marker, open the Functions pop-up 
menu and select the “Insert Marker” option. 
A position marker is added at the current project cursor position on the 
marker track. 

• To add a cycle marker, open the Functions pop-up 
menu and select the “Insert Cycle Marker” option.
This adds a cycle marker between the left and right locators on the 
marker track. 

• To move one or more markers to a specific position, set 
the project cursor to the desired position, select the mark-
ers, and select the “Move Markers to Cursor” option from 
the Functions pop-up menu.
You can also move markers by entering the new position numerically in 
the Position column. If a cycle marker is selected, the Move operation af-
fects the cycle marker start position. 

• To remove a marker, select it and select the “Remove 
Marker” option from the Functions pop-up menu.

Auto-Scroll with Project Cursor
This option helps you to keep track of the locate arrow, 
even if your project contains a large number of markers. 
When this option is activated, the window is automatically 
scrolled to keep the locate arrow visible.

Navigating in the marker list
You can navigate in the marker list using your computer 
keyboard and select entries by pressing [Enter]. This is a 
quick and easy way to jump to markers during playback or 
recording:

• To move to the previous/next marker in the list, press 
[Up Arrow]/[Down Arrow]. 

• To jump to the first/last marker, press [PageUp]/[Page-
Down]. 

Auto-Scroll with 
Project Cursor

Type pop-up 
menu

Functions 
pop-up menu

Locate 
arrow
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Support for the Yamaha XF data 
format
Cubase Studio now supports the Yamaha XF format. XF 
is an extension of the standard MIDI file format that allows 
saving of song-specific data with a MIDI file of type 0.

When importing a MIDI file containing XF data, this data is 
placed in parts on separate tracks called “XF Data”, “Chord 
Data”, or “SysEx Data”. You can edit such a part in the List 
Editor (e.g. to add or change lyrics).

Cubase Studio can also export XF data as part of a MIDI 
file of type 0. If you do not want to export the XF data to-
gether with the MIDI data, mute or delete the track(s) con-
taining the XF data.

Track Quick Controls improvements
Track Quick Controls are now available for audio, instru-
ment, MIDI, group, FX, and output channels.

! Do not change the order of events within the XF data 
or the event data itself, unless you have a lot of expe-
rience with XF data.
17
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3
The MediaBay



Introduction
One of the biggest challenges in typical computer-based music production environments is how to manage the ever-
growing number of plug-ins, instruments, presets, etc. from multiple sources. Cubase Studio features an efficient data-
base for media file management that allows you to handle all your media files from within your sequencer program.

The MediaBay is divided into several sections:

• Define Locations – Here, you can create “presets” for locations 
on your system that you want to scan for media files, see “Defin-
ing Locations” on page 22.

• Locations – Here, you can switch between the previously de-
fined Locations.

• Filters – Here, you can filter the Results list using a logical or 
an attribute filter, see “The Filters section” on page 28.

• Results – Here, all found media files are displayed. You can 
also filter the list and perform text searches, see “The Results 
list” on page 23.

• Previewer – This section allows you to preview the files shown 
in the Results list, see “Previewing files” on page 26.

Important notice for users updating to Cubase 
Studio 5.5

Accessing the MediaBay
To open the MediaBay, select the MediaBay command on 
the Media menu. You can also use the corresponding key 
command (by default F5).

The Previewer 
section

The Define
Locations

section

The Locations section

The Filters
section

The Results
list

! When updating Cubase Studio from versions 4.x, 
5.0.x, or 5.1 to 5.5, please note that any previously 
existing MediaBay database files are not supported. 
To create a database, Cubase Studio 5.5 has to res-
can your system for media files.
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Setting up the MediaBay window
You can show and hide the different sections of the 
MediaBay (except for the Results list). This is handy, as it 
allows you to save screen space and enables you to dis-
play only the information you need for your work.

Proceed as follows:

1. Click the “Set up Window Layout” button in the lower 
left corner of the MediaBay window.

A transparent pane appears, covering the window. In the center of it is a 
gray area containing checkboxes for the different sections.

2. Deactivate the checkboxes for the sections you want 
to hide from view. 
Any changes you make here are directly reflected in the MediaBay window. 
Note that the Results list cannot be hidden.

You can also use key commands for this: use the up/
down and left/right arrow keys to step through the check-
boxes and press [Space] to activate/deactivate the de-
sired checkbox.

3. When you are done, click outside the gray area to exit 
the Setup mode.
Alternatively, you can wait a few seconds for the pane to disappear auto-
matically.

• You can change the size of the individual MediaBay sec-
tions by dragging the divider line between two sections.

Working with the MediaBay
When working with many music files, the most important 
thing is to find the content you need quickly and easily. 
The MediaBay helps you find and organize your content in 
an effective and efficient way. After the first scan of the 
folders you have activated for scanning (which will take a 
certain time), all the files that were found are there for you 
to browse, tag or modify. 

At the beginning, all media files of the supported formats 
are listed in the Results section: far too many to get a 
good overview. However, by using the search and filter 
techniques, you get the desired results very quickly.

The first thing to do is to set up “Locations”, that is folders 
or directories on your system that contain media files. Usu-
ally, files are organized in a specific way on your computer. 
For example, you might have folders reserved for audio con-
tent, folders for special effects, folders for combinations of 
sounds making up the ambience noise you need for a cer-
tain film take, etc. These can all be set as different Loca-
tions in the MediaBay, allowing you to limit the files available 
in the Results list according to context.

Whenever you expand your computer system (for exam-
ple, by adding new hard disks or an external volume con-
taining media files you want to work with), you should 
make it a habit to save the new volumes as Locations or 
add them to your existing Locations. Afterwards, you can 
hide the Define Locations section from view. That way, the 
MediaBay occupies less screen space and you can con-
centrate on the important thing: the Results list. 

For this list, you can specify which file types are displayed, 
see “Filtering according to media type” on page 23. If 
there are still too many files to choose from, you can nar-
row down the results using a text search function, see 
“Performing a text search” on page 24. This is often all it 
needs to display what you want, allowing you to proceed 
by previewing the files before inserting them into your 
project (see “Previewing files” on page 26). However, if 
you need more complex and detailed filtering, this is also 
possible using attribute filtering, see “Applying an attribute 
filter” on page 28.

Finally, the files can be easily inserted into the project, by 
using drag & drop, by double-clicking or using the context 
menu options, see “Inserting the files into the project” on 
page 25.
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The Define Locations section

When you open the MediaBay for the first time, a scan for 
media files is performed on your system. You specify which 
folders or directories you want to be included in the scan by 
activating/deactivating the checkboxes for the folders in the 
Define Locations section. Depending on the amount of me-
dia files on your computer, the scan may take a while. All 
files that are found in the specified folders are shown in the 
Results list.

• To include a folder in the scan, activate its checkbox.

• To exclude a folder from the scan, deactivate its check-
box.

• To restrict the search to individual subfolders, activate/
deactivate their checkboxes.

The color of the checkmark helps you to identify which 
folders and subfolders are scanned:

• A white checkmark indicates that all subfolders are scanned.
• An orange checkmark indicates that at least one subfolder is 

excluded from the scan.

• To revert to scanning a complete folder (including all 
subfolders), click on an orange checkmark.
The checkmark becomes white, to indicate that all folders are scanned.

The scanning status for the individual folders themselves 
is indicated by the color of the folder icons:

• A red icon means that the folder is currently being scanned.
• A light blue icon means the folder has been scanned.
• A dark blue icon is displayed for folders which are excluded 

from the scan.
• An orange icon is displayed when the scanning process for 

the folder was interrupted.
• A yellow icon is displayed for folders that have not yet been 

scanned.

The scan result is saved in a database file. When you de-
activate the checkbox for a folder that has already been 
scanned, a message appears, allowing you to keep the 
gathered scan data in this database file or to completely 
remove the data for this folder from the database file. Se-
lect Keep if you want to keep the database entries, but 
want to exclude the folder from being scanned (when you 
trigger a re-scan for example). Select Remove if you do 
not want to use the contents of this folder in your projects.

• When you activate the “Please, don’t ask again” option, 
no further warning messages will be shown when you de-
activate other checkboxes, for as long as the program is 
running.
When you quit and re-launch Cubase Studio, these warning messages 
will be displayed again.

The VST Sound node
The Define Locations section provides a shortcut to user 
content and factory content files, including the preset 
folders: the VST Sound node.

• The folders below the VST Sound node represent the 
directories in which content files and track presets, VST 
presets, etc. are stored by default.
To find out the “true” location of a file, right-click on it in the Results list 
and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac). This will 
open an Explorer/Finder window in which the corresponding file is high-
lighted. Please note that this function is not available for files which are 
part of a VST Sound archive.

Some subfolders of this folder
are excluded from the scan.

All subfolders of this folder are
included in the scan.
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Updating the display
You can update the display in two ways: by rescanning or 
by refreshing.

Rescanning

When you click the Rescan button, the selected folder is 
rescanned. If a folder contains a large number of media 
files, the scanning process may take some time. Use this 
function if you have made changes to the content of spe-
cific media folders and want to scan these folders again.

You can also rescan the selected folder by right-click-
ing on it and selecting Rescan Disk from the context menu.

Refreshing

In addition to the Rescan Disk option, the context menu for 
the selected node or folder in the Define Locations section 
also contains a Refresh Views option. This refreshes the 
display for this location without rescanning the correspond-
ing media files.

This is useful in the following situations:

• When you have mapped a new network drive, for exam-
ple, and want this to appear as a node in the Define Loca-
tions section. Simply select the Refresh Views option for 
the parent node and the new drive will appear in the De-
fine Locations section (ready to be scanned for media 
files).

Defining Locations 
When you have set up the Define Locations section ac-
cording to your preferences, and the content is scanned, it 
is time to make it available in a meaningful way. For this, 
you can define locations, i.e. shortcuts to the folders you 
want to work with, that will be available from the Locations 
section for convenient access.

To define a location, proceed as follows:

1. In the list to the left, select the desired folder.

2. Click the Add button.
A naming dialog for the new location is displayed.

3. Accept the default name or enter a new name.

4. Click OK.
The new location is added to the Locations pop-up menu in the Loca-
tions section (see below).

5. Repeat these steps to add as many locations as you 
need.

Once you have set up your locations, you can hide the 
Define Locations section from view (see “Setting up the 
MediaBay window” on page 20), to save screen space.

Some Location presets are available by default. These 
are: “All Media” (the topmost node in the Define Locations 
section), “Local Harddisks” (the local harddisks in your 
computer system) and “VST Sound” (the folder in which 
Steinberg sound files, loops and presets are stored by 
default).

The Locations section
When you open the Locations pop-up menu and select a 
location, the media files found in that location are shown in 
the Results list. By switching between the locations you 
defined, you can quickly browse to the files you are look-
ing for.

• To change the browse location, simply select another 
location from the pop-up menu.
If the available Locations don’t yield the desired results or if the folder 
you want to scan for files is not part of any of the locations, define a new 
Location in the Define Locations section.

• To select the previous or next folder in a sequence of 
selected folders, use the “Previous/Next Browse Location” 
buttons.
These paths will be deleted when you close the MediaBay.

• To select the parent folder of the selected folder, click 
the “Browse Containing Folder” button.

• To remove a location from the pop-up menu, select it 
and click the “Remove Browse Location Definition” button.

Previous/Next 
Browse Location

Browse Containing Folder

Click here to open the pop-up menu 
and select the desired Location.

Remove Browse Location Definition

Deep 
Results
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• To show the files contained in the selected folder and 
any subfolders (without showing these subfolders), acti-
vate the Deep Results button.
When this button is deactivated, only the folders and files contained in 
the selected folder are shown.

The Results list
The Results list is at the heart of the MediaBay. Here, you 
will find all the files found in the selected location.

As the number of files displayed can be huge (the info 
field in the top right corner of the Results section shows 
the number of files found with the current filter settings), 
you might want to use any of the filter and search options 
in the MediaBay to narrow down the list. The available op-
tions are described below.

The maximum number of files that are displayed in the 
Results list can be set by specifying a new value for “Max-
imum Items in Results list” in the Preferences (see “Prefer-
ences” on page 30).

Filtering according to media type
The Results list can be set to display only a particular me-
dia type or a combination of media types.

• Click in the field where the currently displayed media 
types are shown (by default “All Media Types”) to open 
the Show Media Types dialog.
Here, you can activate the media types you want to be displayed in the 
Results list.

When you have filtered the list to show a particular media 
type, this is indicated by the corresponding icon to the left 
of media type field. When you have selected several 
media types, the Mixed Media Type icon is used.

The media types

In the “Show Media Types” dialog, you can activate the 
media types you want to be displayed in the Results list. 
The following types are available:

Option Description

Audio Files When this is activated, the list shows all audio 
files. The supported formats are .wav, .aiff, .aifc, 
.rex, .rx2, .mp3, .mp2, .ogg, .sd2, .wma (Windows 
only).

MIDI Files When this is activated, the list shows all MIDI files 
(file name extension .mid).

MIDI Loops When this is activated, the list shows all MIDI 
loops (file name extension .midiloop).

Pattern Banks When this is activated, the list shows all pattern 
banks (file name extension .patternbank). Pattern 
banks are generated by the MIDI plug-in Beat De-
signer. For more information, see “Previewing pat-
tern banks” on page 27 and the separate PDF 
document “Plug-in Reference”.

Track Presets When this is activated, the list shows all track pre-
sets for audio, MIDI, and instrument tracks (file 
name extension .trackpreset). Track presets are a 
combination of track settings, effects and mixer set-
tings that can be applied to new tracks of various 
types. For more information, see the chapter “Work-
ing with track presets” in the Operation Manual.

Select this option to 
display all types.

Here, the last four media 
type selections you 
made are listed.

The media types you 
activate here are shown 
in the Results list.
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Setting up the Results list columns
For each media type, or for combinations of media types, 
you can specify the attribute columns that are displayed in 
the Results list.

Proceed as follows:

1. Select the media type (or combination of media types) 
that you want to make settings for.

2. Click the “Set up Result Columns” button and activate 
or deactivate the options on the submenus.

Activate the attributes that you want to be displayed in the Results list.

If you want to see none of the attributes of a certain 
category, choose the “Select None” option on the corre-
sponding submenu.

Performing a text search
You can limit the number of results in the Results list using 
the text search function. When you enter text in the Text 
Search field, only media files whose attributes match the 
entered text will be displayed.

For example, if you are looking for all audio loops relating 
to drum sounds, simply enter “drum” in the search field. 
The search results will contain loops with names such as 
“Drums 01”, “Drumloop”, “Snare Drum”, etc. Also, all me-
dia files with the Category attribute Drum&Percussion, or 
any other attribute that contains “drum” will be found.

When you enter text in the field, its background becomes 
red, to indicate that a text filter is active for the list. To re-
set the text filter, delete the text.

Boolean text search

You can also perform advanced searches, using boolean 
operators or wildcards. The following elements can be 
used:

Plug-in Presets When this is activated, the list shows all VST pre-
sets for instrument and effect plug-ins. These pre-
sets contain all parameter settings for a particular 
plug-in. They can be used to apply sounds to in-
strument tracks and effects to audio tracks. For 
more information, see the chapter “Working with 
track presets” in the Operation Manual.

Video Files When this is activated, the list shows all video files.

Projects When this is activated, the list shows all project 
files (from Cubase, Nuendo, Sequel): .cpr, .npr, 
.steinberg-project.

Option Description

Click here to open the pop-up menu.

Option Description

And [+] [a and b] – When entering strings separated by “and” (or 
a plus sign), all files are found that contain both a and b.
[And] is the default setting when no boolean operator is 
used, i.e. you can also enter [a b].

Or [,] [a or b] – When entering strings separated by “or” (or a 
comma), files are found that contain either a or b, or both.

Not [-] [not b] – When entering text preceded by “not” (or a mi-
nus sign), all files not containing b will be found.

Parentheses 
[( )]

[(a or b) + c] – Using parentheses, you can group text 
strings. In this example, files are found that contain c and 
either a or b.

Quotation 
marks [“ ”]

[“example text”] – With quotation marks, you can define 
sequences of several words. Files are found if they con-
tain this sequence of words.

! When you are searching for files whose name con-
tains a hyphen, put the search text in quotation marks, 
because otherwise the program will treat the hyphen 
as the boolean operator “not”.
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The rating slider

Using the rating slider above the Results list, you can 
specify rating settings for your files, ranging from 1 to 5. 
This makes it possible to exclude certain files from the 
search according to their quality.

When you move the rating slider, the active rating filter is 
indicated in red. All files of this rating are displayed in the 
list.

The search in progress indicator
At the top right in the Results list you will find an indicator 
which shows whether the MediaBay is currently searching 
for files.

Resetting the list
When you have set up filters for the Results list, you can 
set everything back to default by clicking the Reset Re-
sults Filter button to the right of the Rating slider.

This will delete any text in the text search field, set the rat-
ing slider to display all files and deactivate all the media 
type filters.

Inserting the files into the project
You can insert files into the project by right-clicking on 
them and selecting one of the “Insert into project” options 
from the context menu, or you can double-click them. 
What happens next depends on the track type:

Audio files, MIDI loops, and MIDI files can be inserted into 
the project by double-clicking them in the Results list. They 
will be inserted on the active track, if this matches the file 
type or onto a new track if no corresponding track is active. 
The files will be inserted at the current project cursor posi-
tion.

Similarly, if you double-click on a track preset, it will be ap-
plied to the active track, if the track type matches the track 
preset. Otherwise, a new track will be inserted, containing 
the settings of the track preset.

If you double-click a VST preset, an instrument track is 
added to the project, containing an instance of the corre-
sponding instrument. For some VST presets, this will load 
the entire instrument settings, programs, etc. For others, 
only one program will be loaded, see “Applying instrument 
presets” on page 32.

When you double-click on a pattern bank, a new MIDI 
track is created in the Project window, with an instance of 
the Beat Designer plug-in as insert effect which is using 
this pattern.

Managing files in the Results list
• You can move/copy a file from the Results list to an-
other location by clicking on it and dragging it to another 
folder in the Define Locations section.
You will be asked whether you want to copy or move the file to the new 
location.

• You can change the display order in the Results list by 
clicking on a column heading, and dragging that heading 
to another position in the display.

• To delete a file, right-click it in the list and select Delete 
from the context menu.
A warning message is displayed, asking you to confirm that you really 
want to move this file to the operating system’s trash folder. The data you 
delete here will be permanently deleted from your computer, therefore be 
sure to delete only the files you do not want to use any more.

With this setting, only files with a rating of at 
least 2 are displayed.

When this indicator is shown, a media search is in 
progress.

! When a file was deleted in the Explorer/Finder, it will 
still be displayed in the Results list, although it is no 
longer available to the program. To remedy this, you 
have to re-scan the corresponding folder.
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Previewing files
When you have sufficiently narrowed down the list of files, 
you will want to preview individual files to find out which 
one to use in your project. This is done in the Previewer 
section.

Note that some MediaBay-specific Preferences affect the 
playback of media files, see “Preferences” on page 30. 

The elements visible in this section and their functions 
depend on the type of media file.

Previewing audio files

To preview an audio file, click the Play button. What hap-
pens next depends on the following settings:

• When “Auto Play New Results Selection” is activated, 
any file you select in the Results list is automatically played 
back.

• When “Align Beats to Project” is activated, the file you 
selected for preview in the Results list is played back in 
sync with the project, starting at the project cursor posi-
tion. Note that this may apply realtime time stretching to 
your audio file.
When you import an audio file into your project for which “Align Beats to 
Project” is activated in the Previewer, Musical mode is automatically ac-
tivated for the corresponding track.

• When “Wait for Project Play” is activated, the Play and 
Stop functions from the Transport panel are synchronized 
with the Play and Stop buttons in the Previewer section.
This option is very useful for previewing audio loops. To use it to its full 
extent, set the left locator at the beginning of a bar, then start playing 
back the project using the Transport panel. The loops that you now se-
lect in the Results list will start together with the project in perfect sync. 
Play and Stop of the Previewer transport can still be used if needed.

Previewing MIDI files

To preview a MIDI file (.mid), you first have to select an 
output device from the Output pop-up menu.

• “Auto Play New Results Selection” and “Align Beats to 
Project” work as for audio files, see above.

When working with long MIDI files, you can click in the 
timeline to jump to a specific position in the file.

Previewing MIDI loops
To preview a MIDI loop file, click the Play button.

• “Auto Play New Results Selection” works as for audio 
files, see above.
MIDI loops are always played back in sync to the project.

Previewing VST presets and track presets for 
MIDI and instrument tracks

Track presets for audio tracks can only be previewed 
in the Presets browser (see the chapter “Working with 
Track Presets” in the Operation Manual).

Track presets for MIDI or instrument tracks and VST pre-
sets require MIDI notes for previewing. These notes can 
be sent to the track preset in the following way:

• Via MIDI Input
• Using a MIDI file
• Using the Memo Recorder
• Via the computer keyboard

! The Previewer section is not available for video files, 
project files, and audio track presets.

Preview 
level

Transport 
controls

Auto Play New 
Results Selection

Align Beats 
to Project

Wait for 
Project Play

OutputTransport controls

Computer 
keyboard input

Sequence Mode 
pop-up menu

Transport 
controls

Preview Level 
fader
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These methods will be described in the following sections.

Previewing presets via MIDI Input

MIDI input is always active, i.e. when a MIDI keyboard is 
connected to your computer (and set up properly), you 
can directly start playing the notes to preview the selected 
preset.

Previewing presets using a MIDI file

Proceed as follows:

1. On the Sequence Mode pop-up menu, select “Load 
MIDI File”.

2. In the file dialog that opens, navigate to the desired 
MIDI file, and click Open.
The name of the MIDI file is displayed on the pop-up menu.

3. Click the Play button to the left of the pop-up menu.
The notes received from the MIDI file are now played back with the settings 
of the track preset applied.

The recently used MIDI files are kept on the menu, for 
quick access. To remove an entry from this list, select it on 
the menu and then select “Remove MIDI File”.

Previewing presets using the Memo Recorder

The Memo Recorder function continually repeats a given 
sequence of notes as a loop.

To use the Memo Recorder, proceed as follows:

1. On the Sequence Mode pop-up menu, select Memo 
Recorder.

2. Enter the notes via the MIDI or computer keyboard.
The Play button is automatically activated and you will instantly hear the 
notes you play with the preset settings applied.

• When you stop playing notes and wait for 2 seconds, 
the note sequence you played until this moment will be 
played back in a continuous loop. 
To use another sequence, simply start entering notes again.

You cannot use the Memo Recorder when previewing 
presets using a MIDI file.

Previewing presets via the computer keyboard

Proceed as follows:

1. Activate the “Computer Keyboard Input” button.

The keyboard display in the Previewer section works in the 
same way as the Virtual Keyboard, see the chapter “Play-
back and the Transport panel” in the Operation Manual.

2. Enter the notes via the corresponding keys on the 
computer keyboard.

Previewing pattern banks
Pattern banks containing drum patterns can be created 
with the MIDI plug-in Beat Designer. Detailed information 
on the Beat Designer and its functions can be found in the 
chapter “MIDI effects” in the separate PDF document 
“Plug-in Reference”. One pattern bank contains 4 sub-
banks which in turn contain 12 patterns each. In the Pre-
viewer section for a pattern bank file, a keyboard-style 
display allows you to select a subbank (click on a number 
at the top) and a pattern (click on a key).

• To preview a pattern, select the pattern bank in the Re-
sults list. In the Previewer section, choose a subbank and 
pattern. Then click the Play button.
Note that subbanks can contain empty patterns. Selecting an empty pat-
tern in the Previewer section will have no effect. Patterns containing data 
are indicated by a circle in the upper part of the key in the display. 

! When you activate the “Computer Keyboard Input” 
button, the computer keyboard is used exclusively for 
the Previewer sections, i.e. the usual key commands 
are blocked. The only exceptions are: 
[Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop 
Record), [Space] (Start/Stop Playback), Num [1] 
(Jump to left locator), [Delete] or [Backspace] 
(Delete), Num [/] (Cycle on/off), and [F2] (Show/
Hide Transport panel).

Transport 
controls

Preview 
level

Auto Play New 
Results Selection
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• “Auto Play New Results Selection” works as for audio 
files, see above.

The Filters section
With the MediaBay, you can perform very refined file 
searches.

Applying an attribute filter

The MediaBay allows you not only to view and edit some 
of the standard file attributes found in all computer files, 
but it also provides preconfigured attributes, or “tags”, 
that you can use to organize your media files.

The Filters section displays all values found for a specific 
attribute. Selecting one of these values will result in a list of 
files all showing this particular attribute value. For example, 
you could look for sample rates and pick 44.1 kHz to give 
you a list of all files with that particular sample rate.

The advantages of the use of attributes become obvious 
when having to find a specific file in a large database, 
without knowing the name of that file.

The Filters section always shows attribute columns, each 
with its own list of attribute values. If the columns are wide 
enough, the number of files that match this criteria is dis-
played to the right of the filter name.

You define an Attribute filter by clicking on the values in an 
attribute column: only the files that match the selected at-
tribute values are then shown in the Results list. Select 
more attribute values from other columns to further refine 
your filter.

• Selected attribute values in the same column form an 
OR condition.
This means that files must be tagged according to either one or the other 
attribute value to be displayed in the Results list.

Note that this is not true for the Character attribute, 
which always forms an AND condition, see below.

• Attribute values in different columns form an AND con-
dition.
This means that files must be tagged according to all these attribute val-
ues to be shown in the Results list.

Assigning attribute values to your files makes it easy to 
organize the media files

Further options for Attribute searches

• You can change which attribute type is displayed in 
each column by clicking on the column title and selecting 
another attribute from the context menu.

• You can select an attribute value, by clicking on it. To 
deselect it, click the value again.
Note that you can select more than one value in each attribute column.

• You can clear all settings in the attribute columns by 
clicking the Reset Filter button at the top right of the Fil-
ters section.
Clicking this button also resets the Results list.

! Some attributes are directly linked to each other (e.g. 
for each Category value, there are certain Sub Cate-
gory values available). Changing the value in one of 
these attribute column will give you different values in 
the other column!

! Each attribute column displays only the attribute val-
ues found in the currently selected location! This 
means that selecting another location may lead to 
the display of different attributes.
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Editing Attributes

Editing attributes in the Results list

Attributes can be edited directly in the Results list. This al-
lows you, for example, to assign tags to a library of loop 
files.

Proceed as follows:

1. In the Results list, select the file(s) for which you want 
to change an attribute value.

2. Click in the column for the tag value you want to assign.
Depending on the attribute type, a pop-up menu with tag values organized 
in submenus will show or, in the case of numeric values, you will be able to 
enter the value directly into the corresponding field.

3. Choose values from the pop-up menus and/or enter 
the desired numeric values.

Editing the attributes of multiple files simultaneously

There is no limit as to how many files can be tagged at the 
same time, but you need to be aware that the tagging of a 
large amount of files in one go may take quite a while. This 
operation is executed in the background, so that you can 
continue with your work as usual. By looking at the At-
tribute Counter above the Results list, you can see how 
many files still have to be updated.

• If you close Cubase Studio before the Attribute Counter 
has gone down to zero, a dialog with a progress bar is dis-
played, indicating how long the updating process will take. 
You can choose to abort this process.
In this case only the files that were updated before you clicked “Abort” 
will have the new attribute values.

Editing the attributes of write-protected files

Media files may be write-protected due to a number of rea-
sons: They may belong to content that was provided by 
someone else who write-protected the files, you may have 
write-protected them yourself in order not to overwrite them 
accidentally, or the file format could restrict write operations 
by the MediaBay.

In the MediaBay, the write protection status of files is 
shown in the Write Protection column in the Results list.

However, there may be cases when you want to define at-
tributes for write-protected files. For example, you might 
want to apply attributes to the content files that came with 
Cubase Studio or you are working on the same files with 
several people and cannot modify these files. In these 
scenarios, you still want to be able to find files quickly and 
improve your workflow.

Therefore, it is possible to change the attribute values of 
write-protected files in the MediaBay. These changes are 
not written to disk though and occur in the MediaBay only.

• When you specify attribute values for a file that is write-
protected, this is reflected in the Pending Tags column 
next to the Write Protection column in the Results list.
Note that if you rescan the MediaBay content and a media file on your 
hard disk has changed since the last scan, all pending tags for this file 
will be lost.

• If a file has pending tags, and you want to write the cor-
responding attributes to the file, you need to remove the 
write protection first, and then select the “Write Tags to 
File” command from the context menu.

• You can change the write-protection status of your me-
dia files, provided that the file type allows write operations 
and you have the necessary operation system permis-
sions: To set or remove the write protection attribute for a 
file, simply select the file in the Results list and select 
“Set/Remove Write Protection” from the context menu.

If you use other programs than Cubase Studio to 
change the write-protection status of a file, this will not be 
reflected in the MediaBay until you rescan the files!
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The Loop Browser and Sound 
Browser windows
The Loop Browser and Sound Browser items on the Me-
dia menu open two different “views” of the MediaBay. The 
Loop Browser is preconfigured for quickly browsing your 
“loops”, i.e. audio files, MIDI loops, and pattern banks. The 
default browse location is the VST Sound node. Similarly, 
the Sound Browser is set up for you to be able to quickly 
search the desired sound, without having to configure the 
window. By default, it is set to display track presets and 
plug-in presets. The default browse location is the VST 
Sound node.

The Loop Browser and Sound Browser offer the same 
functions as the MediaBay, i.e. you can specify different 
browse locations, define searches, set up the available 
panes as desired, etc., as described previously in this 
chapter.

Preferences
In the Preferences dialog in Cubase Studio, you can find 
options and settings that control the global behavior of the 
program. The Preferences dialog contains a special Media-
Bay page. These settings are also available from within the 
MediaBay.

To open the Preferences pane for the MediaBay, proceed 
as follows:

1. Click the MediaBay Preferences button in the lower 
left corner of the window.

• A transparent pane appears, covering the window. In 
the center of it is a gray area where the available prefer-
ences for the Locations section and the Results list are 
displayed.

2. Configure the MediaBay to your liking by activating/
deactivating the options.

The following options are available in the Locations sec-
tion:

The following options are available in the Results section:

Option Description

Show Managed 
Locations Only

Activate this to hide all folders that are not scanned 
for files. This will keep the tree view in the Define Lo-
cations section less cluttered.

Use Current 
Selection as Base 
Location

Activate this to show only the selected folder and its 
subfolders. To switch back to the display of all folders, 
deactivate this option.

Scan Folders Only 
when MediaBay is 
Open

When this is activated, Cubase Studio only scans for 
media files when the MediaBay window is open. 
When this is deactivated, the folders are scanned in 
the background even when the MediaBay window is 
closed. However, Cubase Studio will never scan fold-
ers while playing back or recording.

Option Description

Maximum 
Items in 
Results List

Use this parameter to specify the maximum number of 
files that are displayed in the Results list. This avoids un-
manageably long lists of files. 
Note that the MediaBay does not warn you if the maxi-
mum number of files has been reached and there might 
be situations where a certain file you were looking for 
could not be found, because the maximum number of files 
was reached.

Show File 
Extensions in 
Results List

When this is activated, file name extensions (e.g. .wav or 
.cpr) are displayed in the Results list.
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Key commands
You can display the available MediaBay key commands 
from within the MediaBay window. This is useful if you 
want to get a quick overview over the assigned and the 
available MediaBay key commands.

To open the Key Commands pane, proceed as follows:

1. Click the Key Commands button in the lower left cor-
ner of the window.

A transparent pane appears, covering the window. In the center of it is a 
gray area where the available key commands are displayed.

• If you only want to get an overview over the key com-
mands, you can exit the pane by clicking on its back-
ground (not in the gray area).

• If you want to assign or modify key commands, click in 
the gray area.
The Key Commands dialog opens, in which you can set up and edit key 
commands, see the chapter “Key commands” in the Operation Manual.

Working with MediaBay-related 
windows
The MediaBay concept can be found throughout the pro-
gram, for example when adding new tracks or when choos-
ing presets for VST instruments or effects. The workflow in 
all MediaBay-related windows is the same as in the Media-
Bay. Below follow a few examples.

Adding tracks
When you select one of the Add Track options on the 
Project menu, the following dialog opens:

The Add Track dialog for audio tracks

Click the Browse button to expand the dialog to show the 
Results list (as you can find it in the MediaBay). However, 
only file types that can be used in this context are shown.

You can also apply track presets to existing tracks. The di-
alog that opens in this case is the same as above.
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Applying effect presets
When you have added an insert effect, you can choose 
from a variety of presets via the Presets pop-up menu for 
the effect slot. 

The Preset browser opens:

Applying instrument presets
When working with VST instruments, you can choose 
from a variety of presets via the Presets pop-up menu. 

The Preset browser opens:

VST presets for instruments can be divided into two 
groups: “presets” containing the settings of the whole plug-
in (for multi-timbral instruments, this means the settings for 
all sound slots as well as the global settings) and “pro-
grams” containing only the settings for one program (for 

multi-timbral instruments, this means only the settings for 
one sound slot). In the MediaBay, they can be recognized 
by their icons. This way, you can see directly whether a VST 
preset contains a single sound or more.

Icon Description

This preset contains settings for all loaded programs.

This program only contains settings for the first or the se-
lected instrument slot.
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Window overview

The Sample Editor allows you to view and manipulate audio 
by cutting and pasting, removing, or drawing audio data, 
and by processing or applying effects. This editing is “non-
destructive”: The actual file (if created or imported from out-
side the project) will remain untouched so that you can 
undo modifications or revert to the original settings at any 
time using the Offline Process History dialog. For more in-
formation see the chapter “Audio processing and func-
tions” in the Operation Manual.

The Sample Editor also contains most of the AudioWarp 
related functions, i.e. the realtime time stretching as well 
as the pitch-shifting functions in Cubase Studio. These 
can be used to match the tempo of audio loops to the 
project tempo (see “AudioWarp: Tempo matching audio” 
on page 43).

Another special feature of the Sample Editor is hitpoint 
detection. Hitpoints allow you to create “slices”, which 
can be useful in many situations, for example, if you want 
to change the tempo without affecting the pitch (see 
“Working with hitpoints and slices” on page 48).

The term “loop” is used throughout this chapter and in 
this context usually means an audio file with a musical time 
base. That means that the length of the loop represents a 
certain number of bars and beats at a certain tempo. Play-
ing the loop back at the right tempo in a cycle set to the 
correct length will produce a continuous loop without gaps.

Opening the Sample Editor
To open the Sample Editor, double-click an audio event in 
the Project window or the Audio Part Editor, or double-
click an audio clip in the Pool. You can have more than 
one Sample Editor window open at the same time.

Double-clicking an audio part in the Project window 
opens the Audio Part Editor, even if the part contains a sin-
gle audio event only. For more information, see the chapter 
“The Audio Part Editor” in the Operation Manual.

The toolbar

To the right of the tools, the estimated length of your audio 
file is displayed in bars and beats (PPQ) together with the 
estimated tempo and the time signature. If you want to use 
Musical Mode, always verify that the length in bars corre-

Audition, Loop, and 
Volume controls

Set up Window
Layout

Solo Editor

Acoustic Pitch
Feedback

Suspend Auto-Scroll 
when editing

Auto-Scroll

Show Audio 
Event

Show 
Regions

Snap on/off

Snap to Zero
Crossing

Musical 
Mode

Tool buttons
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sponds to the audio file you imported. If necessary, listen 
to your audio and enter the correct bar length. The Algo-
rithm pop-up menu allows you to select an algorithm for 
the realtime time stretching.

You can customize the toolbar by right-clicking it and us-
ing the context menu to hide or show items. For further in-
formation about configuring the toolbar, see the chapter 
“Customizing” in the Operation Manual.

The info line
The info line is displayed below the toolbar. It shows infor-
mation about the audio clip:

Initially, length and position values are displayed in the for-
mat specified in the Project Setup dialog. For information 
about configuring the info line, see the chapter “Customiz-
ing” in the Operation Manual. 

• To show or hide the info line, click the “Set up Window 
Layout” button on the toolbar and activate or deactivate 
the Info Line option.

The Sample Editor Inspector
On the left in the Sample Editor, you will find the Sample 
Editor Inspector. It contains tools and functions for work-
ing in the Sample Editor. 

For more information on the handling of the various In-
spector tabs, see the chapter “The Project Window” in 
the Operation Manual.

The Definition tab

The Definition tab helps you to adjust the audio grid and 
define the musical context of your audio. This is useful if 
you have an audio loop or audio file that you want to match 
to the project tempo, see “AudioWarp: Tempo matching 
audio” on page 43. If the Definition tab is open, a second 
ruler is displayed, showing the musical structure of your 
audio.

The AudioWarp tab

The AudioWarp tab lets you perform timing settings for 
your audio. This includes applying swing and manually 
changing the rhythm of the audio by dragging beats to 
time positions in the grid (see “Free Warp” on page 47).

• If you click the “Disable Warp Changes” button, any 
warp modifications you have made are disabled, allowing 
you to compare the modified sound with the original 
sound of your audio. 
However, the display does not change. The time stretch applied by the 
Musical Mode is not disabled by this. “Disable Warp Changes” is deac-
tivated when you reset your warp operations or when you close the Sam-
ple Editor. It will not be recalled when reopening the Sample Editor.

Global Transpose statusAudio format and length

Selected display format 

Number of edits made to the clip

Zoom factor

Realtime status

Original pitch and deviation

Pitch and deviation

Current selection range

Disable Warp Changes
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The Hitpoints tab

On this tab, the transients or hitpoints of the audio can be 
marked and edited (see “Working with hitpoints and 
slices” on page 48). Hitpoints allow you to slice your au-
dio, and to create groove quantize maps from your audio. 
You can also create markers, regions, and events based 
on hitpoints.

The Range tab

On this tab you will find functions for working with ranges 
and selections (see “Making selections” on page 39).

The Process tab

This tab regroups the most important audio editing com-
mands from the Audio and Edit menus. For further infor-
mation on the options contained in the Select Process 
and Select Plug-in pop-up menus, see the chapter “Audio 
processing and functions” in the Operation Manual.

The Overview line

The Overview line displays the whole clip. The section cur-
rently shown in the main waveform display of the Sample 
Editor (the viewing area) is indicated by a rectangle in the 
Overview line, and the current selection range is also 
shown. If the “Show Audio Event” button is activated on the 
toolbar, event start/end and snap point are shown in the 
Overview line.

• To view other sections of the clip, move the viewing 
area in the Overview line.
Click in the lower half of the viewing area and drag to the left or right to 
move it.

• To zoom in or out, horizontally, resize the viewing area 
by dragging its left or right edge.

• To define a new viewing area, click in the upper half of 
the Overview and drag a rectangle. 

The ruler
The Sample Editor ruler is located between the Overview 
line and the waveform display. The ruler is explained in de-
tail in the chapter “The Project window” in the Operation 
Manual. When the Definition tab is open, an additional 
ruler displays the musical structure of the audio file.

Event start Event end

Viewing area

Selection

Snap point
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The waveform display and the level scale

The waveform display shows the waveform image of the 
edited audio clip according to the wave image style set in 
the Preferences dialog (Event Display–Audio page), see 
the chapter “The Project window” in the Operation Man-
ual. To the left of the waveform display a level scale is 
shown, indicating the amplitude of the audio.

• You can select whether the level is shown as a percent-
age or in dB.
This is done by opening the level scale pop-up menu at the top of the 
level scale and selecting an option. 

• Select the “Show Half Level Axis” option on the context 
menu of the waveform display, if you want the half level 
axes to be shown.

Operations

Zooming
Zooming in the Sample Editor is done according to the 
standard zoom procedures, with the following special 
notes to keep in mind:

• The vertical zoom slider changes the vertical scale rela-
tive to the height of the editor window, in a way similar to 
the waveform zooming in the Project window (see the 
chapter “The Project window” in the Operation Manual).
The vertical zoom will also be affected if the “Zoom Tool Standard Mode: 
Horizontal Zooming Only” preference (Editing–Tools page) is deactivated 
and you drag a rectangle with the Zoom tool.

The following options relevant to the Sample Editor are 
available on the Zoom submenu of the Edit menu or the 
context menu:

• The current zoom setting is shown in the info line, as a 
“samples per screen pixel” value.

You can zoom in horizontally to a scale of less than one 
sample per pixel! This is required for drawing with the Pen-
cil tool (see “Drawing in the Sample Editor” on page 42).

• If you have zoomed in to one sample per pixel or less, the 
appearance of the samples depends on the “Interpolate 
Audio Images” option in the Preferences dialog (Event Dis-
play–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If 
the option is activated, they are interpolated to a “curve” form.

Half level axis

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to 
Selection

Zooms in so that the current selection fills the editor 
display.

Zoom to 
Selection (Horiz.)

Zooms in horizontally so that the current selection fills 
the editor display.

Zoom to Event Zooms in so that the editor shows the section of the 
clip corresponding to the edited audio event. This is 
not available if you have opened the Sample Editor 
from the Pool (in which case the whole clip is opened 
for editing, not an event).

Zoom In/Out 
Vertically

This is the same as using the vertical zoom slider (see 
above).

Undo/Redo 
Zoom

These options allow you to undo/redo the last zoom 
operation. 
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Auditioning
While you can use the regular play commands to play 
back audio when the Sample Editor is open, it is often 
useful to listen to the edited material only.

The Main Mix bus is always used for all auditioning.

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have made a selection, this selection will be played back.
• If there is no selection and “Show Event” is deactivated, play-

back will start at the cursor position.
• If the Audition Loop icon is activated, playback will continue 

repeatedly until you deactivate the Audition Loop icon. Other-
wise, the section will be played back once.

There is a separate Play button for auditioning regions, 
see “Auditioning regions” on page 41.

Using the Speaker tool

If you click somewhere in the waveform display with the 
Speaker (“Play”) tool and keep the mouse button pressed, 
the clip is played back from the position where you click. 
Playback will continue until you release the mouse button.

Using Acoustic Feedback

If you activate the “Acoustic Pitch Feedback” button on 
the toolbar, the audio will be played back when you edit it 
vertically, i.e. when you change the pitch. This way you 
can easily audition your modifications. 

Using key commands

If you activate the “Playback Toggle triggers Local Pre-
view” option in the Preferences dialog (Transport page), 
you can start/stop auditioning by pressing [Space]. This is 
the same as clicking the Audition icon on the toolbar.

The Sample Editor also supports the “Preview start” 
and “Preview stop” key commands in the Media category 
of the Key Commands dialog. These key commands stop 
the current playback, whether you are in normal playback 
or in audition mode.

Scrubbing

The Scrub tool allows you to locate positions in the audio 
by playing back, forwards, or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse 
button pressed.
The project cursor is moved to the position where you clicked.

3. Drag to the left or right.
The audio is played back. The speed and pitch of the playback depend 
on how fast you drag.

Adjusting the snap point
The snap point is a marker within an audio event. It is used 
as a reference position when you move events with snap 
activated, so that the snap point is “magnetic” to whatever 
snap positions you have selected.

By default, the snap point is set at the beginning of the au-
dio event, but often it is useful to move the snap point to a 
“relevant” position in the event, such as a downbeat.

To adjust the snap point, proceed as follows:

1. Activate the “Show Audio Event” option on the tool-
bar, so that the event is displayed in the editor.

2. If needed, scroll until the event is visible, and locate 
the “S” flag in the event.
If you have not adjusted this previously, it is located at the beginning of 
the event.

3. Click on the “S” flag and drag it to the desired position.
You can also adjust the snap point by setting the project cursor at the de-
sired position, and selecting “Snap Point To Cursor” on the Audio menu.

The snap point will be set to the position of the cursor. 
This method can also be used in the Project window and 
the Audio Part Editor.
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It is also possible to define a snap point for a clip (for 
which there is no event yet).

To open a clip in the Sample Editor, double-click it in the 
Pool. After having set the snap point you can insert the 
clip into the project from the Pool or the Sample Editor 
with the set snap point position.

Making selections
To select an audio section in the Sample Editor, click and 
drag with the Range Selection tool.

• If “Snap to Zero Crossing” is activated on the toolbar, 
the selection’s start and end are always at zero crossings.

• You can resize the selection by dragging its left and 
right edge or by [Shift]-clicking.

• The current selection is indicated in the corresponding 
fields on the Range tab of the Sample Editor Inspector.
You can fine-tune the selection by changing these values. Note that the 
values are relative to the start of the clip, rather than to the project timeline.

Using the Select menu

On the Select menu on the Range tab and in the Select 
submenu of the Edit menu you find the following options:

Editing selection ranges
Selections in the Sample Editor can be processed in sev-
eral ways. 

If you attempt to edit an event that is a shared copy (i.e. 
the event refers to a clip that is used by other events in the 
project), you are asked whether you want to create a new 
version of the clip.

• Select “New Version” if you want the editing to affect 
the selected event only. Select “Continue” if you want the 
editing to affect all shared copies.

! When you set the grid start on the Definition tab, the 
snap point is moved to the grid start (see “Manual 
Adjust” on page 44).

! Events and clips can have different snap points. If 
you open a clip from the Pool you can edit the clip 
snap point. If you open a clip from within the project 
window, you can edit the event snap point. The clip 
snap point serves as a template for the event snap 
point. However, it is the event snap point that is 
taken into account when snapping.

A selected range

Option Description

Select All Selects the whole clip.

Select None Selects no audio (the selection length is set to “0”).

Select in Loop Selects all audio between the left and right locator.

Select Event Selects only the audio that is included in the edited event. 
This is grayed out if you have opened the Sample Editor 
from the Pool (in which case the whole clip is opened for 
editing, not an event).

Locators to
Selection 
(Range tab 
only)

Sets the locators to encompass the current selection. 
This is available if you have selected one or several 
events or made a selection range.

Locate Selection 
(Range tab only)

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must have 
selected one or more events or parts, or made a selec-
tion range.

Loop Selection 
(Range tab only)

This activates playback from the start of the current se-
lection and keeps starting over again when reaching the 
selection end.

From Start 
to Cursor (Edit 
menu only)

Selects all audio between the clip start and the project 
cursor.

From Cursor 
to End (Edit 
menu only)

Selects all audio between the project cursor and the 
end of the clip. For this to work, the project cursor must 
be within the clip boundaries.

Left Selection 
Side to Cursor 
(Edit menu only)

Moves the left side of the current selection range to the 
project cursor position. For this to work, the cursor must 
be within the clip boundaries.

Right Selection 
Side to Cursor 
(Edit menu only)

Moves the right side of the current selection range to 
the project cursor position (or the end of the clip, if the 
cursor is to the right of the clip).
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If you activate the “Please, don’t ask again” option in 
the dialog, any further editing will conform to the selected 
method (“Continue” or “New Version”). You can change 
this setting at any time with the “On Processing Shared 
Clips” pop-up menu in the Preferences dialog (Editing–
Audio page).

• Any changes to the clip are shown in the Offline Pro-
cess History, making it possible to undo them later (see 
the chapter “Audio processing and functions” in the Op-
eration Manual).

Cut, Copy, and Paste

The Cut, Copy, and Paste commands (on the Edit menu, 
on the Process tab of the Sample Editor Inspector, or in 
the main Edit menu) work according to the following rules:

• Selecting Copy copies the selection to the clipboard.

• Selecting Cut removes the selection from the clip and 
moves it to the clipboard.
The section to the right of the selection is moved to the left to fill the gap.

• Selecting Paste copies the data from the clipboard into 
the clip.
If there is a selection in the editor, this is replaced by the pasted data. If 
there is no selection, the pasted data is inserted starting at the project 
cursor. The section to the right of the line is moved to make room for the 
pasted material.

Delete

Selecting Delete (on the Edit menu, on the Process tab of 
the Sample Editor Inspector, or in the main Edit menu) re-
moves the selection from the clip. The section to the right 
of the selection is moved to the left to fill the gap.

Insert Silence

Selecting “Insert Silence” (on the Edit menu, on the Pro-
cess tab of the Sample Editor Inspector, or in the Range 
submenu of the main Edit menu) inserts a silent section 
with the same length as the current selection, at the selec-
tion start.

• The selection is not replaced, but moved to the right to 
make room. 
If you want to replace the selection, use the “Silence” function instead 
(see the chapter “Audio processing and functions” in the Operation 
Manual).

Processing

The Processing features (on the Select Process menu, on 
the Process tab of the Sample Editor Inspector, or in the 
Process submenu of the Audio menu) can be applied to 
selections in the Sample Editor, as well as the effects (on 
the Select Plug-in menu on the Process tab of the Sample 
Editor Inspector or in the Plug-ins submenu of the Audio 
menu). For more information, see the chapter “Audio pro-
cessing and functions” in the Operation Manual. 

Creating a new event from the selection using 
drag & drop

To create a new event that plays only the selected range, 
proceed as follows:

1. Make a selection range.

2. Drag the selection range to an audio track in the 
Project window.

Creating a new clip or audio file from the selection

To extract a selection from an event and either create a 
new clip or a new audio file, proceed as follows:

1. Make a selection range.

2. Open the context menu and select “Bounce Selec-
tion” from the Audio submenu.

A new clip is created and added to the Pool, and another 
Sample Editor window opens with the new clip. This clip 
refers to the same audio file as the original clip, but con-
tains the audio corresponding to the selection range only.

Working with regions
Regions are sections within a clip. One of the main uses 
for regions is Cycle recording, in which the different 
“takes” are stored as regions (see the chapter “Record-
ing” in the Operation Manual). You can also use this fea-
ture for marking important sections in the audio clip. 
Regions can be dragged into the Project window from the 
Sample Editor or the Pool to create new audio events. 

Regions are best created, edited, and managed in the 
Sample Editor.
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Creating and removing regions

1. Select the range that you want to convert into a region.

2. Click the “Set up Window Layout” button and activate 
the Regions option.
The regions list is displayed on the right.

3. Click the Add Region button above the regions list (or 
select “Event or Range as Region” from the Advanced 
submenu of the Audio menu).
A region is created, corresponding to the selected range.

4. To name the region, double-click on it in the list and 
enter a new name.
Using this procedure, regions can be renamed at any time.

• When you click on a region in the regions list, it is in-
stantly displayed in the Sample Editor.

• To remove a region from a clip, select it in the list and 
click the Remove Region button above the list.

Creating regions from hitpoints

If your audio event contains calculated hitpoints, you can 
choose to automatically create regions from hitpoints. This 
can be useful to isolate recorded sounds. For further infor-
mation on hitpoints, see “Working with hitpoints and 
slices” on page 48.

Editing regions

The region selected in the list is displayed in gray in the 
waveform display and the overview line.

There are two ways to edit the start and end positions of a 
region:

• Click and drag the region start and end handles in the 
waveform display (with any tool).
When you move the pointer over the handles, it automatically changes to 
indicate that you can drag the handles.

• Edit the Start and End positions in the corresponding 
fields in the regions list.
The positions are shown in the display format selected for the ruler and 
info line, but are relative to the start of the audio clip rather than the 
project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and 
clicking the Play Region button above the list. The region 
will play back once or repeatedly, depending on whether 
the Loop icon on the toolbar is activated or not.

You can also listen to a region by selecting it in the list and 
clicking the Audition icon on the toolbar. This way you can 
preview separate regions by clicking on them in the list or 
by selecting them with the up/down arrow keys on your 
computer keyboard.

Making selections from regions

If you select a region in the list and click the Select Region 
button above, the corresponding section of the audio clip 
is selected (as if you had selected it with the Range Se-
lection tool) and zoomed. This is useful if you want to ap-
ply processing to the region only. 

You can also double-click a region in the Pool to have 
its audio clip opened in the Sample Editor with the area of 
the region automatically selected.

Creating audio events from regions

To create new audio events from regions using drag & 
drop, proceed as follows:

1. In the list, click on the region and keep the mouse but-
ton pressed.

2. Drag the region to the desired position in the project 
and release the mouse button.
A new event is created.

• You can also use the “Events from Regions” function 
from the Advanced submenu of the Audio menu (see the 
chapter “The Project window” in the Operation Manual).
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Exporting regions as audio files

If you create a region in the Sample Editor, the region can 
be exported to disk as a new audio file. This is done from 
the Pool, see the chapter “The Pool” in the Operation 
Manual.

Drawing in the Sample Editor
It is possible to edit the audio clip at sample level by draw-
ing with the Pencil tool. This can be useful if you need to 
manually edit out a spike or click, etc.

Proceed as follows:

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform 
display.
When you release the mouse button, the edited section is automatically 
selected.

Options and settings

Show Audio Event

When the “Show Audio Event” button is activated on the 
toolbar, the section corresponding to the edited event is 
highlighted in the waveform display and the Overview. The 
sections of the audio clip not belonging to the event are 
shown with a gray background.

• In this mode, you can adjust the start and end of the 
event in the clip by dragging the event handles in the 
waveform display.

Snap

The Snap function helps you to find exact positions when 
editing in the Sample Editor by restricting horizontal 
movement and positioning to certain grid positions. You 
turn Snap on or off by clicking the Snap button in the 
Sample Editor toolbar.

The Sample Editor Snap function is independent of 
the Snap setting in the Project window toolbar or other 
editors. It has no effect outside the Sample Editor.

Snap to Zero Crossing

When this option is activated, editing is done at zero 
crossings (positions in the audio where the amplitude is 
zero). This helps you to avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

If hitpoints have been calculated, these are also taken 
into account when snapping to zero crossings.

The Sample Editor function “Snap to Zero Crossing” 
is independent of the same setting in the Project window 
toolbar or other editors. It has no effect outside the Sam-
ple Editor.

Auto-Scroll

When the Auto-Scroll option is activated on the Sample 
Editor toolbar, the waveform display will scroll during play-
back, keeping the project cursor visible in the editor.

This setting is independent of the Auto-Scroll setting 
in the Project window toolbar or other editors.

! This button is only available if you have opened the 
Sample Editor by double-clicking an audio event in 
the Project window or the Audio Part Editor. It is not 
available if you have opened the audio event from the 
Pool.
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AudioWarp: Tempo matching audio
AudioWarp means realtime time stretching functions in 
Cubase Studio. The main AudioWarp features are tempo 
matching audio loops to the project tempo and matching 
up an audio clip with fluctuating tempo to a fixed tempo.

Musical Mode
If you want to tempo match an audio loop to the project 
tempo, you will normally work with loops with straight 
beats. In this case you only need to activate the Musical 
Mode on the toolbar. 

The Musical Mode is one of the key AudioWarp features. 
It allows you to lock audio clips to the project tempo by 
using realtime time stretching. This is very useful if you 
want to use loops in your project without worrying too 
much about timing.

When Musical Mode is activated, audio events will adapt 
to any tempo changes in Cubase Studio, just like MIDI 
events.

You can activate Musical Mode on the AudioWarp tab, the Definition 
tab, and the toolbar.

It is also possible to activate/deactivate Musical Mode 
from within the Pool by clicking the corresponding check-
box in the Musical Mode column. 

To tempo match an audio loop to the project tempo, pro-
ceed as follows: 

1. Import your loop into the project and double-click it to 
open the Sample Editor.
If you open the Definition tab and take a look at the rulers, you will see 
that the project tempo grid (upper ruler) and the grid of your audio (lower 
ruler) do not match.

2. Activate the Musical Mode button on the toolbar.
Your clip is warped and stretched automatically to adapt it to the project 
tempo. The rulers reflect the change.

In the Project window, the audio event is now shown with 
a note symbol and a double arrow in the bottom right cor-
ner to indicate that Musical Mode is activated.

The Musical Mode state is saved with the project. This al-
lows you to import files into the project with Musical Mode 
already activated. The tempo is also saved when exporting 
files.

! Cubase Studio supports ACID® loops. These loops 
are standard audio files but with embedded tempo/
length information. When ACID® files are imported 
into Cubase Studio, Musical Mode is automatically 
activated and the loops will adapt to the project 
tempo.
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Auto Adjust
If you want to use an audio file with unknown tempo or if 
the beat of your loop is not straight, you have to change 
the “definition” of this audio file first. This is done with the 
Auto Adjust function on the Definition tab of the Sample 
Editor Inspector.

The Auto Adjust function quantizes your audio automati-
cally, i.e. the transients are moved to exact note values in 
the audio grid. 

Proceed as follows:

1. Open the Sample Editor and define a selection range 
for your audio clip. 
Alternatively, you can define a range by setting the start and end of the 
audio event. 

2. Open the Definition tab and click the Auto Adjust 
button.
The transients, i.e. the significant positions of your audio are moved to 
exact note values in the audio grid.

3. Activate the Musical Mode button on the toolbar.
Your clip is warped and stretched automatically to adapt it to the project 
tempo. The rulers reflect the change.

You can see that the event snap point is moved to the 
start of the selected range. If you take a look at the lower 
ruler, you will see that red vertical lines are shown. These 
indicate that your audio has been aligned to bar and beat 
positions.

Manual Adjust
You might have a very special loop where the automatic 
function does not lead to satisfying results. In this case 
you can manually adjust the grid and tempo of your audio 
file. Proceed as follows:

1. Open the Definition tab in the Sample Editor Inspector 
and activate the Manual Adjust tool.

2. Select a suitable value from the Grid pop-up menu.
This determines the grid resolution for your audio. The vertical lines of the 
grid represent bar positions, and the red vertical lines beat positions.

3. Move the mouse pointer to the beginning of the audio 
file until the tooltip “Set Grid Start” is displayed.
The mouse pointer turns into a double arrow to indicate that you can edit 
the time grid for the audio file.

4. Click and drag to the right to set the grid start at the 
first downbeat, and release the mouse button.
The lower ruler (for the audio) changes to reflect your edits. 

5. Audition the file to determine where the second bar in 
the sample begins.
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6. In the upper part of the waveform, move the mouse 
pointer to the vertical line nearest to the second bar so 
that the tooltip “Stretch Grid” and a blue vertical line are 
shown.
The functionality of the Manual Adjust tool changes depending on its po-
sition, e.g. if applied in the lower part of the waveform on a vertical line, it 
is used to set a bar position, see below.

7. Click and drag the blue vertical line to the left or right 
to the position of the first downbeat in the second bar and 
release the mouse button.
The beginning of the next bar is set, and all following bars are stretched 
or compressed by the same amount.

8. Check the positions of the following bars and, if nec-
essary, move the mouse pointer over the grid lines in the 
lower part of the waveform until the tooltip “Set Bar Posi-
tion (Move Following Bars)” and a green vertical line are 
shown.
This allows you to set the bar positions. When you drag the mouse, the 
beginning of the next bar is set, and the tempo of the previous bar is 
changed.

9. Now have a look at the single beats in between the 
bars and, if necessary, move the mouse pointer to a beat 
position to adjust them.
The Set Beat Position function is displayed with a light blue line. Drag it 
until the single beat position is aligned with the waveform, and release 
the mouse button. 

• If you are not satisfied with a specific edit, you can hold 
down any modifier key and click on the adjusted grid line 
(bar or beat).
The Eraser tool appears together with a tooltip indicating that you can re-
move your edit.

When you are done, you can activate Musical Mode to ad-
just your audio loop to the project tempo.
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Applying swing
If you find that your audio sounds too straight, e.g. after 
having quantized it with the Auto Adjust function, you can 
add swing. Proceed as follows:

1. Activate Musical Mode.

2. On the AudioWarp tab, select a suitable grid resolu-
tion from the Resolution pop-up menu.
This defines the positions that the swing is applied to. If you select 1/2, 
the swing is applied in steps of half notes, if you select 1/4, it is applied 
in steps of quarter notes, etc.

3. Move the Swing fader to the right to offset every sec-
ond position in the grid.
This creates a swing or shuffle feel. 

Depending on how far you move the fader to the right and 
what grid resolution you chose, this function offers every-
thing from half-note swing to 64th-note swing. 

Selecting an algorithm for realtime playback
In the Algorithm pop-up menu on the toolbar you can se-
lect the algorithm preset to be applied on realtime play-
back. This setting affects warp changes in Musical Mode, 
FreeWarp, and Swing.

On this pop-up menu you can find various options that 
govern the audio quality of the realtime time stretching. 
There are presets that allow you to manually set warp 
parameters:

If you select the Advanced menu item, a dialog opens 
where you can manually adjust the three parameters that 
govern the sound quality of the time stretching:

Option Description

Drums This mode is best for percussive sounds, because it does not 
change the timing of your audio. Using this option for pitched 
audio will lead to noticeable artifacts. In this case, you can try 
the Mix mode.

Plucked Use this mode for audio with transients and a relatively stable 
spectral sound character (e.g. plucked instruments).

Pads Use this mode for pitched audio with slower rhythm and a sta-
ble spectral sound character. This minimizes sound artifacts, 
but the rhythmic accuracy is not preserved.

Vocals This mode is suitable for slower signals with transients and a 
prominent tonal character (e.g. vocals).

Mix This mode preserves the rhythm and minimizes the artifacts 
for pitched material which does not meet the above criteria 
(i.e. with a less homogenous sound character). 
This is selected by default for audio that is not categorized.

Advanced This allows for a manual tweaking of the time stretching pa-
rameters. By default, the settings that are shown when you 
open the dialog are those of the last preset used (except if the 
Solo mode has been selected, see below). The Advanced 
settings are described more in detail below this table.

Solo This mode preserves the timbre of the audio. Only use it for 
monophonic material (solo woodwind/brass instruments or 
solo vocals, monophonic synths or string instruments that do 
not play harmonies).

Parameter Description

Grain size The realtime time stretching algorithm splits the audio into 
small pieces called “grains”. This parameter determines the 
size of the grains. For material with many transients, use low 
Grain size values for best results. 

Overlap Overlap is the percentage of the whole grain that will overlap 
with other grains. Use higher values for material with a stable 
sound character.

Variance Variance is also a percentage of the whole length of the 
grains, and sets a variation in positioning so that the overlap-
ping area sounds smooth. A Variance setting of 0 will pro-
duce a sound akin to time stretching used in early samplers, 
whereas higher settings produce more (rhythmic) “smear-
ing” effects but less audio artifacts.
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Free Warp
The Free Warp tool allows you to create warp tabs. Warp 
tabs are a kind of marker or anchor that can be attached to 
musically relevant time positions in an audio event, for ex-
ample the first beat of every bar. Warp tabs can be dragged 
to the corresponding time positions in the project, and the 
audio will be stretched accordingly. 

You can also use warp tabs for further tweaking after hav-
ing activated Musical Mode.

Using the Free Warp tool 
Warp tabs are created using the Free Warp tool on the Au-
dioWarp tab of the Sample Editor, but can also be created 
from hitpoints (see “Creating warp tabs from hitpoints” on 
page 48). In this example, we will show how a file with 
slightly varying tempo can be locked to a steady tempo by 
using warp tabs. It illustrates the general methods of using 
warp tabs and the Free Warp tool. But you can of course 
use warp tabs for other operations than aligning downbeats 
to grid positions. With the Free Warp tool, you can literally 
stretch any region within a sample to any position!

Proceed as follows:

1. Open the audio file that you wish to process in the 
Sample Editor.

2. Activate the “Snap to Zero Crossing” button on the 
Sample Editor toolbar.
When you activate this button, warp tabs will snap to zero crossings and 
hitpoints (if shown).

3. On the Definition tab, click the Auto Adjust button.

4. Line up the audio file so that the first beat of the first 
bar (in the audio event) starts on the first beat of a bar in 
the project.

• If the audio file does not start on a downbeat, you can 
use the Event Start handle in the Sample Editor and adjust 
the position in the Project window so that the first down-
beat in the sample is aligned with the first beat of a bar in 
the grid.
Now the first musical downbeat should be aligned with the first beat of a 
bar in the project. 

The next step is to find out where the first warp tab needs 
to be added. Activate the metronome click on the Trans-
port panel and play back your audio clip to determine po-
sitions where its tempo drifts from the project tempo. 

5. Play back the audio file and determine where the first 
beat of a bar in the audio event does not match the corre-
sponding ruler position in the project.
If you find it difficult to pinpoint an exact position in the audio event, you 
can use the Scrub tool and/or zoom in the view.

6. On the AudioWarp tab, select the Free Warp tool, 
place the pointer at the position of the beat that you want 
to adjust, click, and hold.
When you place the mouse pointer in the waveform display, it changes 
to a clock with arrows on either side and a vertical line in the middle, 
which represents the pointer. 

7. With the mouse button still pressed, drag the warp tab 
to the desired position in the ruler and release the mouse 
button.
A warp tab is added and your beat should be perfectly aligned with the 
corresponding position in the project. If the position where you clicked 
was off, you can adjust it by dragging the handle.

You can also first add warp tabs at the relevant musi-
cal positions and change their positions later, see “Editing 
warp tabs” on page 48.

Next to the warp tab handle in the ruler, a number is 
shown. This number indicates the warp factor, i.e. the 
amount of stretch. Warp factor numbers higher than 1.0 
indicate that the audio region preceding the warp tab is 
expanded and will play back slower. Warp factor numbers 
lower than 1.0 indicate that the audio region preceding 
the warp tab is compressed and will play back faster.

8. Repeat the described steps to align the first beat in 
each bar to the corresponding ruler position.

! When you activate or deactivate Musical Mode or 
select another Resolution value, all your warp modifi-
cations will be lost.
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You only have to add warp tabs where the downbeat 
in the audio file drifts from the ruler position and/or if you 
want to lock a warp tab so that it is not moved when edit-
ing other points. 

Editing warp tabs

Moving the destination of existing warp tabs

To move the destination position of a warp tab (and thus 
stretch or compress the audio), select the Free Warp tool 
and position the pointer on the warp line in the waveform, 
click and drag. 

Moving the insert position of existing warp tabs

If you wish to change the insert position of a warp tab in 
the audio, click and drag the warp tab handle in the ruler. 
This will change the warping.

Disabling warp tabs

You can disable all warp modifications by clicking the 
“Disable Warp Changes” button on the AudioWarp tab. 

Deleting warp tabs

To delete a warp tab, hold down [Alt]/[Option] so that the 
pointer becomes an eraser and click on the warp tab. To 
delete several warp tabs, hold down [Alt]/[Option] while 
drawing a selection rectangle.

Resetting warp modifications

To reset your Free Warp edits, click the Reset button on 
the AudioWarp tab. This also resets the “Disable Warp 
Changes” button on the same tab.

If Musical Mode is activated, only Free Warp edits are 
reset.

Creating warp tabs from hitpoints

You can also create warp tabs from hitpoints by selecting 
“Create Warp Tabs from Hitpoints” on the Realtime Pro-
cessing submenu of the Audio menu.

Working with hitpoints and slices
Hitpoint detection is a special feature of the Sample Edi-
tor. It detects attack transients in an audio file and adds a 
type of marker, i.e. a “hitpoint”, at each transient. These 
hitpoints allow you to create “slices”, where each slice 
ideally represents each individual sound or “beat” in a loop 
(drum or other rhythmic loops work best with this feature). 
When you have successfully sliced the audio file, you can 
do a number of useful things with it:

• Change the tempo without affecting the pitch.
• Extract the timing (a groove map) from a drum loop. The 

groove map can then be used to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the 

basic feel.
• Extract sounds from loops.

You can further edit these slices in the Audio Part Editor. 
You can, for example:

• Remove or mute slices.
• Change the loop by reordering, replacing, or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce 

Selection” function on the Audio menu.
• Transpose in realtime and stretch slices.
• Edit slice envelopes.

Hitpoints are only displayed in the waveform if the Hit-
points tab is open.

Using hitpoints
The main functionality of using hitpoints to slice up a loop 
is to make a loop fit the tempo of a song, or alternatively to 
create a situation that allows the song tempo to be 
changed while retaining the timing of a rhythmic audio 
loop, just like when using MIDI files. 

Which audio files can be used?

Here are some guidelines as to what type of audio files are 
suited for slicing using hitpoints:

• Each individual sound in the loop should have a notice-
able attack.
Slow attacks, legato playing, etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice correctly.
In these cases, try to normalize the files or to remove DC Offset.
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• There may be problems with sounds drowned in smear-
ing effects, like short delays.

Calculating hitpoints and slicing a loop

Before proceeding, check if your audio file is suited for 
slicing using hitpoints, see above. Proceed as follows:

1. Open the Hitpoints tab and select an option from the 
Use pop-up menu. 
The Use pop-up menu on the Hitpoints tab affects which hitpoints are 
shown and is a useful tool for removing unwanted hitpoints. 
The following options are available:

If you select one of the options of the Use pop-up 
menu (except “All”), a second ruler that displays the musi-
cal structure of the audio file is shown below the ordinary 
ruler. 

2. Move the Sensitivity slider to the right to add hitpoints 
or to the left to remove unwanted hitpoints until one indi-
vidual sound is played between two hitpoints.
If your main reason for slicing the loop is to change the tempo, you gen-
erally need as many slices as you can get, but never more than one per 
individual “hit” in the loop. If you want to create a groove, try to get ap-
proximately one slice per eighth note, sixteenth note, or whatever the 
loop requires (see “Creating groove quantize maps” on page 50).

In the next step, the loop will be adapted to the project 
tempo set in Cubase Studio.

3. On the Hitpoints tab, click the Create Slices button or 
select “Create Audio Slices from Hitpoints” from the Hit-
points submenu of the Audio menu. 

The following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that the sections between the 

hitpoints become separate events, all referring to the same 
original file.

• The audio event is replaced by an audio part, containing the 
slices (double-click the part to view the slices in the Audio 
Part Editor).

• The loop is automatically adapted to the project tempo. This 
takes the specified loop length into account: e.g., if the loop 
was one bar long, the part is resized to fit exactly one bar in 
the Cubase Studio tempo, and the slices are moved accord-
ingly, keeping their relative positions within the part.

• In the Pool, the sliced clip is shown with a different icon. Drag-
ging the sliced clip from the Pool to an audio track creates an 
audio part with the slices adapted to the project tempo, just as 
above.

4. Activate cycle playback on the Transport panel.
The loop should now play back seamlessly at the tempo set in the project!

Hitpoints and tempo settings

The musical time base setting and the project tempo af-
fect how your loops are played back. 

• Make sure that the “Musical time base” button in the 
track list or Inspector is activated (the button shows a note 
symbol – see the chapter “The Project window” in the Op-
eration Manual). This way the loop will follow any further 
tempo changes.

• If the project tempo is slower than the original tempo of 
the loop, there may be audible gaps between each slice 
event in the part.
To remedy this, you can use the Close Gaps function on the Advanced 
submenu of the Audio menu, see “Close Gaps” on page 51. Also consider 
activating auto fades for the corresponding audio track – fade-outs set to 
about 10ms will help eliminate any clicks between the slices when you play 
back the part. For more information, see the chapter “Fades, crossfades 
and envelopes” in the Operation Manual.

Option Description

All All hitpoints are shown (taking the Sensitivity slider into ac-
count).

1/4, 1/8, 
1/16, 1/32

Only hitpoints that are close to the selected note value posi-
tions within the loop are shown (e.g. close to exact sixteenth 
note positions). Again, the Sensitivity slider is taken into ac-
count.

Metric Bias This is like the “All” mode, but all hitpoints that are close to 
even meter divisions (1/4, 1/8, 1/16, etc.) get a “sensitivity 
boost” – they are visible at lower sensitivity settings. This is 
useful if you are working with dense or cluttered material with 
a lot of hitpoints, but you know that the material is based on a 
strict meter. By selecting Metric Bias it is easier to find the hit-
points close to the meter position (although most other hit-
points are also available, at higher sensitivity settings).

! When you create slices, all events referring to the 
edited clip are also replaced.
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• If the project tempo is higher than the loop’s original 
tempo, you may want to activate auto crossfades for the 
track.
You can use the Close Gaps functions in this case as well, see “Close 
Gaps” on page 51.

The slices in the Audio Part Editor. Here, the project tempo was higher 
than the loop’s original tempo – the slice events overlap.

Setting hitpoints manually

If you cannot get the desired result by adjusting the sensi-
tivity, try to set and edit hitpoints manually. 

Proceed as follows:

1. Zoom in on the waveform at the point where you wish 
to add a hitpoint.

2. Select the Edit Hitpoints tool to audition the area and 
make sure that the start of the sound is in view.

3. Activate “Snap to Zero Crossing” on the Sample Edi-
tor toolbar.
By finding zero crossings in the waveform (positions where the amplitude 
is close to zero), manually added slices will not insert any clicks or pops. 
All hitpoints calculated by the program are automatically placed at zero 
crossings.

4. Press [Alt]/[Option] so that the mouse pointer changes 
to a pencil tool and click just before the start of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

• If you notice that a hitpoint was either placed too far away 
from the start of the sound or too far into the sound, you can 
move it by dragging the hitpoint to the new position.

5. Audition the slices by pointing and clicking in any slice 
area.
The pointer changes to a speaker icon and the corresponding slice is 
played back from the beginning to the end.

• If you hear a single sound split into two slices you can 
disable an individual slice by clicking on the handle of the 
corresponding hitpoint.
The hitpoint handle gets smaller and its line disappears to indicate that it 
is disabled. To reactivate a disabled hitpoint, click on the hitpoint handle 
again.

• If you hear “double hits” (e.g. a snare hit being followed 
by a hi-hat hit within the same slice), you can add further 
hitpoints manually, or you can move the Sensitivity slider 
to the right until the hitpoint appears and lock the hitpoint 
by holding down [Ctrl]/[Command] or [Shift] and clicking 
on its handle. 
Locked hitpoints are displayed in a darker color. After locking the hitpoint 
you can drag the sensitivity slider to the original setting and the locked 
hitpoint will remain shown. You can unlock a locked hitpoint by clicking 
on its handle.

• If you want to delete a hitpoint, hold down [Ctrl]/[Com-
mand] and click on it. If you want to delete several hitpoints, 
hold down [Ctrl]/[Command] and drag a selection rectan-
gle.
You can also hold down [Shift] and click to delete hitpoints.

Creating groove quantize maps
You can generate groove quantize maps based on the 
hitpoints that you have created in the Sample Editor. 
Groove quantizing is not meant for correcting errors, but for 
creating rhythmic feels. This is done by comparing your re-
corded music with a “groove” (a timing grid generated from 
the file) and moving the appropriate notes so that their tim-
ing matches the one of the groove. In other words, you can 
extract the timing from an audio loop and use it for quantiz-
ing MIDI parts (or other audio loops, after slicing them).

Proceed as follows:

1. Check the audio tempo and define the audio grid.

2. Create and edit hitpoints as described above.
Try to get approximately one slice per eighth note, sixteenth note, or 
whatever the loop requires. It can be helpful to use one of the note value-
based options on the Use pop-up menu (see “Calculating hitpoints and 
slicing a loop” on page 49).

You do not have to create slices – just set up the hit-
points.

! “Snap to Zero Crossing” may alter the timing. In 
some cases it is better to deactivate it, especially if 
you just want to generate a groove quantize map. 
However, if you create slices afterwards, auto fades 
are necessary.
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3. When you have finished setting the hitpoints, click the 
Create Groove button on the Hitpoints tab or select “Cre-
ate Groove Quantize from Hitpoints” from the Hitpoints 
submenu of the Audio menu.
The groove is extracted.

4. If you now pull down the Quantize Type pop-up menu 
in the Project window you find an additional item at the 
bottom of the list, with the same name as the file from 
which you have extracted the groove.
This groove can now be selected as a base for quantizing, just like any 
other quantize value, see the chapter “MIDI processing” in the Operation 
Manual.

5. If you want to save the groove, open the Quantize 
Setup dialog and store it as a preset.

You can also create grooves from a MIDI part by se-
lecting the part and dragging it on the grid display in the 
middle of the Quantize Setup dialog or by selecting “Part 
to Groove” from the Advanced Quantize submenu of the 
MIDI menu.

Other hitpoint functions
On the Hitpoints tab of the Sample Editor Inspector and 
on the various submenus of the Audio menu, you will also 
find the following functions:

Create Markers

If an audio event contains calculated hitpoints, you can 
click the Create Markers button on the Hitpoints tab to 
add a marker for each hitpoint. If your project has no 
marker track, it will be added and activated automatically 
(see the chapter “The Project window” in the Operation 
Manual). Markers can be useful to snap to hitpoints, e.g. 
for locating hitpoints and for using the Time Warp tool 
(see the chapter “Editing Tempo and signature” in the Op-
eration Manual).

Create Regions

If your audio event contains calculated hitpoints, you can 
click the Create Regions button on the Hitpoints tab to 
automatically create regions from hitpoints. This can be 
useful to isolate recorded sounds.

Create Events

When you wish to create separate events according to 
the hitpoints for a file, you can click the Create Events but-
ton on the Hitpoints tab and use any method you like to 
set hitpoints.

The created slices are shown as separate events in 
the Project window.

Close Gaps

This function from the Advanced submenu of the Audio 
menu is useful if you have sliced a loop for tempo changes 
and you change the project tempo. Lowering the project 
tempo below the loop’s original tempo creates gaps be-
tween the slices – the slower the tempo, the wider the 
gaps. Increasing the project tempo over the loop’s original 
tempo compresses the slices using the time stretch func-
tion and creates overlaps. In both cases, you can use the 
Close Gaps function.

Proceed as follows:

1. Set the desired tempo.

2. In the Project window select the part containing the 
slices.

3. From the Advanced submenu of the Audio menu se-
lect “Close Gaps”.
Time stretch is applied to each slice to close the gaps. Depending on the 
length of the part and the algorithm set in the Preferences dialog (Edit-
ing–Audio page), this can take a while.

4. The waveform is redrawn and the gaps are closed!
If you open the Pool, you will see that new clips were created, one for 
each slice.

If you decide to change the tempo again after using the 
Close Gaps function, undo the Close Gaps operation or 
start over again, using the original, unstretched file. 

In the Audio Part Editor or Project window you can 
also use Close Gaps on audio events. This will stretch the 
audio event to the start position of the next event.
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Flattening realtime processing
You can “flatten” realtime processing at any time. This can 
be done to serve two purposes: to reduce the CPU load 
and to optimize the sound quality of the processing. The 
flatten function takes the following into account:

• Warp modifications (see “Free Warp” on page 47), even 
when Bypass is activated. After the flattening, your Warp tabs 
will be lost. However, you can undo this function as usual.

• Event transpose (see the chapter “The Transpose functions” 
in the Operation Manual).

• Select the audio event(s) that you want to process and 
select “Flatten” from the Realtime Processing submenu of 
the Audio menu.
Also use this function before applying any offline processing. When the 
flatten processing is applied, a copy of the original file is automatically 
created in the Pool so that the original audio clip remains intact.

Unstretching audio files

By selecting “Unstretch Audio” from the Realtime Pro-
cessing submenu of the Audio menu, all realtime time 
stretching (by sizing or by warp tabs) is removed.

Note that realtime transpose (in the info line) and Musi-
cal Mode will not be removed by this.

Whether the “Unstretch Audio” menu item is available de-
pends on whether the time stretching has been applied at 
event or clip level: 

• If you have sized an audio event in the Project window 
using “Sizing Applies Time Stretch”, you can undo the 
time stretching by selecting the event in the Project win-
dow and then applying “Unstretch Audio”.
This removes all time stretching and warp tabs.

• When you have entered a tempo and/or length on the 
toolbar, this information is saved for the source clip.
These changes cannot be undone using “Unstretch Audio”.
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Before you start
When working on a project involving a video file, you first 
need to set up your system according to your equipment 
and your demands. The following sections provide some 
general information about video file formats, frame rates, 
and video output devices.

Video file compatibility
Because there are many types of video files, it can be dif-
ficult to determine if one will work on your system. There 
are two ways to figure out if Cubase Studio can play back 
a certain video file:

• Open the video file with QuickTime 7.1 or higher, be-
cause Cubase Studio uses QuickTime for playing back 
video files.

• Check the file information of a video file in the Pool. If 
the information reads “Invalid or not supported file!”, the 
video file is either corrupt or the format is not supported by 
the available codecs.

Video container formats

Video and other multi-media files come in a container for-
mat. This container holds various streams of information 
including video and audio, but also metadata such as syn-
chronization information required to play back audio and 
video together. Data regarding creation dates, authors, 
chapter markings, and more can also be held within the 
container format. 

The following container formats are supported by Cubase 
Studio: 

Cubase Studio supports all these container formats, but 
problems may arise when the computer does not have the 
correct software to decode compressed video and audio 
streams within the container file. You must also know the 
type of codec that was used to create the video file.

Codecs

Codecs are methods of data compression used to make 
video (and audio) files smaller and more manageable for 
computers. In order to play back a video file, your com-
puter must have the correct codec installed in the operat-
ing system to decode the video stream.

If you are not able to load a certain video file, the required 
codec is probably not installed on your computer. In this 
case, you can search the Internet (e.g. the Microsoft or 
Apple web sites) for video codecs.

! Because Cubase Studio 5.5 uses a completely new 
video engine, QuickTime 7.1 and a video card sup-
porting OpenGL 1.2 (OpenGL 2.0 recommended) 
are now required for video playback!

! If you are not able to load a certain video file, you 
must use an external application to convert the file 
into a compatible format or install the required co-
dec. For more information on codecs, see the sec-
tion “Codecs” on page 54.

Format Description

MOV This is a QuickTime movie.

QT This is also a QuickTime movie, but it is only used in Windows.

MPEG-1 This is the first standard of the Moving Picture Experts Group 
for video and audio compression, used for making video CDs. 
Files of this container format can have the extensions “.mpg” 
or “.mpeg”.

MPEG-2 This container format is used for DVD authoring. It can also 
contain AC3 multi-channel audio and has the file extension 
“.m2v”.

MPEG-4 This format is based on the QuickTime movie standard, can 
contain various metadata for streaming, editing, local play-
back, and interchange of content. Its file extension is “.mp4”.

AVI This format is a multimedia container format introduced by 
Microsoft.

DV This is a video format used by camcorders.

! The names of codecs and container formats can be 
confusing. Because many container formats have the 
same names as the codecs they use within the file, 
make sure to differentiate the container format or file 
type (e.g. .mov, .dv) from the codec used within it.
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Frame rates
Cubase Studio is capable of working with different types 
of video and film frame rates. In Cubase Studio the follow-
ing frame rates are available:

• 24fps
This is the true speed of standard film cameras.

• 25fps
This is the frame rate of PAL video.

• 29.97fps
This is the frame rate of NTSC video. The count can be either non-drop
or drop-frame.

• 30fps
This frame rate is not a video standard anymore but has been commonly
used in music recording. Many years ago it was the black and white 
NTSC broadcast standard.

Video output devices
Cubase Studio supports several ways to play back video 
files. Viewing video files onscreen in the Video Player win-
dow may work just fine for many applications, but often it 
is necessary to display video in a large format for viewing 
small details and so others involved in the session can 
also see the video. Cubase Studio provides the ability to 
use several types of video output devices to accomplish 
this.

Multi-head video cards

One of the most common methods is the use of a multi-
head video card installed in the computer. Multi-head 
video cards allow you to connect more than one computer 
monitor to the card, in some cases up to four. If you direct 
the video output of Cubase Studio to one of these out-
puts, the video file is displayed in fullscreen mode on a 
computer monitor or HD television screen. 

You can also use more than one video card to achieve 
the same result. The use of two dual display cards in one 
system (a total of four monitors) is a very common setup 
for film postproduction systems. One output is dedicated 
to video and the other three can be used for Cubase Stu-
dio and other applications.

Different video cards support different types of outputs in-
cluding standard VGA, DVI, S-Video, HDMI, and compo-
nent video. These options allow you to choose the type of 
monitor you use for video. HD televisions and digital pro-
jectors provide the largest viewing screens, but a normal 
computer monitor can function as a very high-quality video 
monitor as well.

Dedicated video cards

The use of a dedicated video card is also supported in 
Cubase Studio. These cards are normally used in video 
editing systems to capture video to disk and display it 
while editing. They usually have a high resolution and take 
some strain off the host CPU by providing video compres-
sion and decompression processing on the card. 

The Decklink cards by Blackmagic Design are auto-
matically recognized by Cubase Studio. Video will be sent 
directly to its output.

FireWire DV Output

You have the option to use FireWire ports on the computer 
to output DV video streams to external converters such as 
various camcorders and standalone FireWire to DV con-
version units. These units can be connected to a television 
or projector for large format viewing. The FireWire protocol 
is capable of transporting data at high speed and is the 
most common standard for communicating with video-
related peripheral equipment.

! Under Windows, it is important that you connect 
your device to the FireWire port before launching 
Cubase Studio. Otherwise it may not be detected 
properly by Cubase Studio.
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Preparing a video project in Cubase 
Studio
The following sections describe the basic operations nec-
essary for preparing a Cubase Studio project involving 
video. It is advisable to store your video files on a separate 
hard drive from your audio files. This can help prevent data 
streaming problems when using high-resolution video with 
many audio tracks. 

Importing video files
Importing a video file into your project is very straight for-
ward once you know that you have a compatible video file. 

Video files are imported in the same manner as audio files:

• By using the File menu (Import–Video File).
In the Import Video dialog, you can activate the “Extract Audio From 
Video” option. This imports any embedded audio streams to a newly cre-
ated audio track positioned below the video track. The new track and the 
clip will get the name of the video file. The new audio event will start at 
the same time as the video event, so that they are in sync with each other. 
If there is no audio stream within the container file, you will get the error 
message “No compatible audio stream found in file”. Click OK and the 
video stream will continue to be imported.

If you try to import a non-supported video file with the 
Import Video option, the Import Video dialog displays the 
text “Invalid or not supported file!”.

• By importing to the Pool first and then dragging to the 
Project window (see the chapter “The Pool” in the Opera-
tion Manual for details).

• By using drag and drop from the Windows Explorer, the 
Mac OS Finder, the Pool, or the MediaBay.

When importing video files via the Pool or by using 
drag and drop, Cubase Studio can automatically extract 
the audio from a video file. Whether this happens, de-
pends on the “Extract Audio on Import Video File” setting 
in the Preferences dialog (Video page). For further infor-
mation about extracting audio from a video file, see “Ex-
tracting audio from a video file” on page 59.

When importing video, Cubase Studio automatically 
creates a thumbnail cache file. The generated file is stored 
in the same folder as the video file and gets the name of 
the file with the suffix “.vcache”.

Video files in the Project window
Video files are displayed as events/clips on a video track, 
with thumbnails representing the frames in the film. 

In the track list and Inspector, you find the following but-
tons:

Some of these buttons may not be visible in the track 
list. With the Track Controls Settings dialog you deter-
mine which buttons are displayed in the track list. For 
more information about customizing track controls, see 
the chapter “Customizing” in the Operation Manual.

! In Cubase Studio, you may work with multiple video 
files of differing frame rates and formats on the same 
video track. Assuming you have the proper codecs 
installed, all video files can be played back in one 
project, but note that proper synchronization of audio 
and video events is ensured only if the frame rate of 
the video file matches the project frame rate (see be-
low).

Button Description

Mute Video When this is activated, video playback is disabled, but 
playback of any other events in the project continues. 
This increases the performance of Cubase Studio when 
realizing operations that do not require watching the 
video.

Show Frame 
Numbers

When this is activated, each thumbnail is shown with the 
corresponding video frame number.

Show 
Thumbnails

With this button you can activate/deactivate the thumb-
nails of a video track.

Lock When this is activated, the video event will be locked. For 
more information about event locking, see the chapter 
“The Project window” in the Operation Manual.

Show frame
numbers

Mute
video

Show 
thumbnails

Lock
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About thumbnails
The individual thumbnail images are positioned exactly at 
the beginning of the corresponding frame. When you 
zoom in and there is enough space between the frames, 
the thumbnail is repeated as many times as there is free 
space available. Thus, you can always see a thumbnail re-
gardless of how much you zoom in.

Thumbnail Memory Cache Size

In the Preferences dialog on the Video page, you can en-
ter a value for the “Thumbnail Memory Cache Size”. This 
determines how much memory is available for displaying 
“real” thumbnails. The currently shown image is buffered 
in the thumbnail memory cache. Whenever you move to 
another image and there is no memory capacity left, the 
“oldest” picture in the cache is replaced by the current 
one. If you have long video clips and/or work with a large 
zoom factor, you may have to raise the “Thumbnail Mem-
ory Cache Size” value.

About thumbnail cache files

When importing video, Cubase Studio automatically cre-
ates a thumbnail cache file. The cache file is used in situa-
tions where the processor load is very high and the correct 
redrawing or realtime calculation of thumbnails might use 
system resources necessary for editing or processing. 
When you zoom in on the thumbnails, you see that they are 
in a lower resolution, i.e. the pictures are not as clear as 
when they are calculated. When the processes that rely 
heavily on the computer CPU are finished, the frames are 
automatically recalculated, i.e. the program automatically 
switches between realtime calculation of the pictures and 
using the cache file.

There are situations where no thumbnail cache file 
can be generated, e.g. if you import a video file from a 
folder that is write-protected. If you have access to the 
host folder at a later stage, you can generate a thumbnail 
cache file manually.

Manually generating thumbnail cache files

If no thumbnail cache file could be generated during im-
port or if you have to “refresh” a thumbnail cache file of a 
certain video file, because the file has been edited with an 
external video editing application, you have the possibility 
to generate the thumbnail cache file manually.

To create a thumbnail cache file manually, you have the 
following possibilities:

• In the Pool, right-click on the video file that you want to 
create a thumbnail cache file for and select the “Generate 
Thumbnail Cache” option from the context menu.
A thumbnail cache file is created, or, in case there already existed a 
thumbnail cache file for the video file, it is “refreshed”.

• In the Project window, open the context menu for the 
video event, and select “Generate Thumbnail Cache” from 
the Media submenu.

• Pull down the Media Menu and select “Generate Thumb-
nail Cache”.

“Refreshing” an already existing thumbnail cache file 
can be done only from within the Pool.

The thumbnail cache file is generated in the back-
ground so that you can continue working with Cubase 
Studio.

Playing back video

To check if your video equipment is capable of playing 
back a video from within Cubase Studio, open the Video 
Player page in the Device Setup dialog. If your system 
does not meet the minimum video requirements, a corre-
sponding message will be displayed. For further informa-
tion on the Device Setup dialog, see below.

Video is played back together with all other audio and 
MIDI material, using the Transport controls.

! For playing back video files, you must have QuickTime 
7.1 or higher installed on your computer. There is a 
freeware version and a “pro” version, which offers ad-
ditional video conversion options. The player engine is 
the same in both versions, so for mere playback in Cu-
base Studio there is no need to purchase the “pro” 
version. 
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Video settings in the Device Setup dialog
In the Device Setup dialog you determine which device is 
used for playing back video files. You can switch between 
different output devices during playback.

The Video Player page in the Device Setup dialog

To set up a video output device, proceed as follows:

1. Pull down the Devices Menu and select “Device 
Setup…” to open the Device Setup dialog, and select the 
Video Player page.

2. In the Active column, activate the checkbox for the de-
vice that you want to use for playing back video. 
All devices in your system that are capable of playing back video are 
listed. The Onscreen Window device serves for playing back the video 
file on your computer monitor. For further information on output devices, 
see the section “Video output devices” on page 55.

3. From the pop-up menu in the Format column, select 
an output format.
For the Onscreen Window output, only a “fixed” format is available. For 
the other output devices, you can select different output formats for play-
back depending on the device.

4. Adjust the Offset setting to compensate for process-
ing delays.
Due to delays while processing video, the video image may not match 
with the audio in Cubase Studio. By using the Offset parameter, you can 
compensate for this effect. The Offset value indicates how many millisec-
onds the video will be delivered earlier in order to compensate for the 
processing time of the video material. Each hardware setup can have dif-
ferent processing delays, so you must try out different values to deter-
mine which value is appropriate. 

The Offset value can be set individually for each out-
put device. It is saved globally for each output device and 
is independent of the project.

The offset is only used during playback. It is defeated 
in stop and scrub mode so that you always see the correct 
video frame.

• If the quality of the video image is not a critical factor or 
if you are experiencing performance problems, try lower-
ing the value on the Video Quality pop-up menu.
Although higher quality settings make the video display sharper and 
smoother, they also lead to an increased processor load.

Playing back video on the computer screen
The Video Player window is used for playing back video 
on your computer screen.

• To open the Video Player window, pull down the De-
vices menu and select Video Player.

Setting the window size and video quality

To resize the Video Player window and/or change the play-
back quality of the video, select the appropriate option on 
the context menu of the Video Player window.

The following options are available:

Option Description

Fullscreen 
Mode

The window is enlarged to occupy the whole (computer) 
screen. If you are working with more than one monitor, you 
can move the Video Player window to an extra monitor. 
Thus, you can work with Cubase Studio on one monitor 
and let the video play back on another monitor. You can 
exit fullscreen mode via the window’s context menu or by 
pressing [Esc] on your computer keyboard.

Quarter Size The window size is reduced to a quarter of the actual size.

Half Size The window size is reduced to half the actual size.

Actual Size The window size corresponds to the size of the video.
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• Drag the borders, just like when resizing other windows.

The higher the resolution, the more processing power 
is needed for playback. If you need to reduce the proces-
sor load, you can reduce the size of the Video Player win-
dow, or lower the value on the Video Quality submenu.

Setting the aspect ratio

Resizing the Video Player window by dragging its borders 
may lead to a distorted image. To prevent this, you can set 
an aspect ratio for video playback.

• From the Aspect Ratio submenu of the Video Player 
context menu, select one of the following options:

When the video is played back in fullscreen mode, the 
aspect ratio of the video is always kept.

Scrubbing video

You can scrub video events, i.e. play them back forwards 
or backwards at any speed. This is done by clicking in the 
Video Player window and moving the mouse to the left or 
to the right.

You can also use the Scrub controls on the Transport 
panel or a jog wheel on a remote controller for scrubbing 
video events. For more information about the jog and 
scrub controls, see the chapter “Playback and the Trans-
port panel” in the Operation Manual.

Editing video
Video clips are played back by events just as audio clips 
are. You can use all the basic editing operations on video 
events, just as with audio events. You can take a single 
event and copy it many times for the creation of mix varia-
tions. A video event may also be trimmed using the event 
handles to remove a countdown for instance. Furthermore, 
you can lock video events just like other events in the 
Project window, and you can edit video clips in the Pool. 

It is not possible to fade or crossfade video events. Fur-
thermore, you cannot use the Draw, Glue, and Mute tools 
with a video event.

Windows only: If you find that you are unable to edit a 
video file copied from a CD, this might be due to the fact 
that files copied from CD are write-protected by default. 
To remove the write-protection, in the Windows Explorer, 
open the Properties dialog and deactivate the “Read-
Only” option.

Extracting audio from a video file
If a video file contains audio, the audio stream can be ex-
tracted. As always when importing audio material, a dialog 
is displayed allowing you to select different import options 
(see the chapter “The Project window” in the Operation 
Manual for details). The extracted audio stream is added to 
the project on a new audio track and can be edited like all 
other audio material.

There are several ways to extract audio from a video file:

• By activating the “Extract Audio From Video” option in 
the Import Video dialog (see the section “Importing video 
files” on page 56).

• By using the “Audio from Video File” option on the Im-
port submenu of the File menu.
This will insert an audio event starting at the project cursor position on 
the selected audio track. If no audio track is selected, a new one will be 
created.

• By activating the “Extract Audio on Import Video File” 
option in the Preferences dialog (Video page).
This will automatically extract the audio stream from any video file during 
import.

Double Size The window is enlarged to twice the actual size.

Video Quality This submenu allows you to change the quality of the video 
image. Higher settings make the video display sharper and 
smoother, but lead to an increased processor load.

Option Description

None The aspect ratio of the video is not kept when resizing the 
window. The image is enlarged/reduced to occupy the 
whole Video Player window.

Internal The Video Player window can be resized at will, but the as-
pect ratio of the video is kept and black borders are dis-
played around the video image to fill the window.

External The resizing of the Video Player window is limited accord-
ing to the aspect ratio of the video image, i.e. the video im-
age always fills the full window and its aspect ratio is kept.

Option Description
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• By using the “Extract Audio from Video File” option on 
the Media menu.
This creates an audio clip in the Pool, but does not add any events to the 
Project window. 

Replacing the audio in a video file
Once you have edited all audio and MIDI data to the video 
and created a final mix, you will need to put the new audio 
back with the video. You can do this by embedding the 
audio in another stream within the video container file.

To replace the audio stream in a video file, proceed as fol-
lows:

1. Place the left locator at the start of the video file in Cu-
base Studio. This will ensure that your audio and video 
streams are synchronized.

2. Pull down the File menu and select the Audio Mixdown 
option from the Export submenu to export the audio file 
you wish to insert into the video container file (for detailed 
information on this function, see the chapter “Export Audio 
Mixdown” in the Operation Manual).

3. From the File menu, select “Replace Audio in Video 
File…”.
A file dialog opens prompting you to locate the video file.

4. Select the video file and click Open.
Next, you are prompted to locate the corresponding audio file. This 
should be the one you created above.

5. Select the audio file and click Open.
The audio is added to the video file, replacing its current audio stream.

Once the process is completed, open the video file in a 
native media player and check for proper synchronization.

! These functions are not available for MPEG-1 and 
MPEG-2 video files.
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AmpSimulator
The AmpSimulator effect now has an updated plug-in 
panel. However, the parameters are the same as before.

AmpSimulator is a distortion effect, emulating the sound 
of various types of guitar amp and speaker cabinet combi-
nations. A wide selection of amp and cabinet models is 
available.

The following parameters are available:

Groove Agent ONE 1.1 update
Replacing individual samples

On the sample pads in Groove Agent ONE, you can now 
replace individual samples. 

• To replace a sample mapped to a pad with another 
sample, drag the new sample to the pad, press [Alt]/[Op-
tion], and drop it.

• To replace a sample in a pad layer with another sample, 
drag the new sample to the Layer indicator, press [Alt]/
[Option], and drop it onto the required layer.

Locating missing files

When a sample belonging to a preset cannot be found, 
Groove Agent ONE prompts you to locate the missing 
files. You can either click Ignore to skip this message, 
click Locate File to navigate to a specific folder containing 
the missing file(s), or click Search Folder to browse a spe-
cific folder and any subfolders that might contain the miss-
ing file(s).

Saving and loading GAK archives

You can now save all Groove Agent ONE settings and the 
sample files referenced by the current configuration as a 
Groove Agent ONE kit. The file name extension of these 
kit files is “*.gak”. 

To save a GAK archive, proceed as follows:

1. Set up Groove Agent ONE the way you want it.

2. In the Exchange section, click the Export button.
The “Export Groove Agent ONE kit” dialog opens in which you can spec-
ify a location and a name for the new archive.

3. Click Save.
The archive is created and the dialog is closed.

A plug-in preset file is created alongside the .gak file. 
This plug-in preset references the samples inside the .gak 
file. It can be browsed in the MediaBay, giving you access 
to all Groove Agent ONE settings (including all samples) 
from within Cubase Studio.

Parameter Description

Drive Controls the amount of amp overdrive. 

Bass Tone control for the low frequencies.

Middle Tone control for the mid frequencies.

Treble Tone control for the high frequencies.

Presence Boosts or dampens the higher frequencies.

Volume Controls the overall output level.

Amplifier 
pop-up menu

This pop-up menu is opened by clicking on the ampli-
fier name shown at the top of the amp section. It allows 
you to select an amplifier model. The amp section can 
be bypassed by selecting “No Amp”.

Cabinet 
pop-up menu

This pop-up menu is opened by clicking on the cabinet 
name shown at the top of the cabinet section. It allows 
you to select a speaker cabinet model. This section can 
be bypassed by selecting “No Speaker”.

Damping Lo/Hi Further tone controls for shaping the sound of the se-
lected speaker cabinet. Click on the values, enter a 
new value and press the [Enter] key.
62
Plug-in updates



To load a GAK file, proceed as follows:

1. In the Exchange section, click the Import button.

2. Navigate to the GAK file and click Open.
The saved settings and all samples are imported into Groove Agent 
ONE.

Polyphony counter

The new Polyphony counter in the LCD Display in the left 
half of the panel shows the number of pads currently play-
ing.

New start/end locators in the waveform display

You can define the sample start and end points by drag-
ging the s and e locators in the waveform shown in the 
LCD display. When you click on a locator and press [Ctrl], 
this will zoom in on the waveform and center the display 
around the locator. Note that the locators automatically 
snap to zero crossings.

Increasing/decreasing parameter values using the 
mouse wheel

As in other areas of Cubase Studio, you can now increase 
or decrease the values for the parameters shown above 
the waveform in the LCD display by clicking and turning 
the mouse wheel. 

Start and end locators

These parame-
ters can be 
changed using 
the mouse 
wheel.
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